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接入 Android
 
  
将 mPaaS 添加到您的项目中
 
  
前提条件
 
  
1、安装 Android Studio
 
mPaaS 框架支持 3.6 及以上版本的 Android Studio。
 

关于 Android Studio 下载，请参见 Android Developers。
安装指南。
如果您之前使用的是低版本 Android Studio 并已经安装了 mPaaS 插件，那么在您从低版本
Android Studio 升级至 3.6 版本的 Android Studio 之后，您只需要升级 mPaaS 插件至最新版本即
可。详情请参见 更新 mPaaS 插件。
  

2、安装 Android Studio mPaaS 插件
 
使用 mPaaS 需要 Android Studio mPaaS 插件进行辅助管理，因此您需要先安装 Android Studio mPaaS 插
件。请参见 安装 mPaaS 插件 以获得更多关于插件安装的信息。
  
3、注册阿里云账号
 
使用 mPaaS 需要阿里云账号，进行 mPaaS 控制台管理，因此您需要准备一个阿里云账号。请参见 阿里云账
号注册流程 以获得更多注册流程指导。
  
4、开通 mPaaS 产品
 
登录阿里云控制台，在 mPaaS 产品页 ，点击 管理控制台，进入 开通产品 页面。点击 立即开通，即可开沟通
mPaaS 产品。
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1.

2.

 

 

 
 
 
Step 1 在控制台创建 mPaaS 应用
 
 

登录 mPaaS 控制台。
选择租户和工作空间。点击目标工作空间即可完成切换。 

移动开发平台mPaaS 接入 Android

2



3.

i.

点击 创建应用。 

 
完善应用信息。
 

（必选）输入应用名称。应用名称示例：mPaaS Demo。
 
（可选）点击 + 上传应用图标。若不上传，则使用默认图标。 
应用图标大小应不超过 1 MB，宽高比为 1:1，尺寸在 50PX - 200PX，图片格式为 JPG
或 PNG。
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5.

 
点击 创建，完成应用创建。可以看到应用列表，并且列表中已经包含了刚才创建的应用。 

 
  
Step 2 将配置文件添加到项目中
 
  
1. 填写配置信息，并上传签名 APK。
 

 
在应用列表页，点击应用名称（如上一步中创建的应用 mPaaS Demo），如下： 
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左上方展示应用名称，您可以在此切换应用。
页面右侧展示 mPaaS 提供的组件服务列表。

 
点击 代码管理 > 代码配置 > Android，输入 Package Name（应用包名）（此处以 
com.mpaas.demo 为例），上传编译并添加签名后的 APK 安装包。 

 

  
2. 下载配置到本地。
 
点击 下载配置，即可获取 mPaaS 的配置文件。
 

说明：此处需要上传签名后的 APK，mPaaS 会根据签名信息进行鉴权。
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配置文件是一个压缩包文件。该压缩包包含一个 .config 文件以及一个 yw_1222.jpg 加密图片。
 

 

 
3. 将配置文件添加到项目中。
 
拷贝 .config 文件到 app 目录下面，如下图所示:
 

说明：
yw_1222.jpg 文件用于适配已经接入了 mPaaS 的客户端工程。如果第一次接入 mPaaS ，请忽略此
文件。

-

确认 .config 文件中 base64Code 的 value 不为空。-
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Step 3 选择适合您的接入方式及基线
 
  
1、选择接入方式
 
mPaaS Android 提供了以下三种接入方式。如果您是初次接触 mPaaS ，建议您使用 原生 AAR 方式 ，此种
方式比另外两种更贴近 Android 技术栈，方便您快速上手。更多关于接入方式的信息，请参见 接入方式简介
。
 

原生 AAR 方式
mPaaS Inside 方式
组件化接入（Portal&Bundle）
  

2、选择基线
 
mPaaS 是基于支付宝的开发平台，因此 mPaaS 会根据支付宝的稳定版本，定期对 mPaaS 的组件进行升级。
基线就是对应支付宝版本号的组件集合。 
mPaaS 提供 10.1.68、10.1.60、10.1.32 基线，对应支付宝的 10.1.68、10.1.60、10.1.32 版本。推荐使用最
新的 10.1.68 基线，该基线支持简单易用的 原生 AAR 方式 。
 
关于基线详细介绍，请参见 基线简介。
 
 
 
Step 4 将 mPaaS SDK 添加到您的项目中
 
  
关于本文
 
本文档基于 原生 AAR 方式 介绍添加 mPaaS SDK 到项目中的流程。
 

如果您使用 mPaaS Inside 方式，请参考 mPaaS Inside 接入流程简介。 
如果您使用 组件化方式（Portal&Bundle），请参考 组件化接入流程简介。 
  

操作步骤
 

 
添加 mPaaS 配置到您的项目中。
  
通过 mPaaS 助手，将 mPaaS 配置集成到项目中。

移动开发平台mPaaS 接入 Android

8



i.

ii.

点击 mPaaS > 原生 AAR 接入 > mPaaS 接入。 

点击 mPaaS。 

 
点击 点击添加。 
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i.

i.

ii.

iii.

选择基线。 

 
添加成功。 
至此已将 mPaaS 添加到项目中。
  
mPaaS 会在项目的build.gradle 中添加以下内容:
 

mPaaS Maven 仓库 
mPaaS Gradle 插件 
mPaaS 基线信息 
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i.

 
 
添加 mPaaS 组件。 
可以通过 mPaaS 助手，将 mPaaS 组件添加到您的项目中。以扫一扫为例。
 

点击 接入扫一扫。 

 
点击 组件接入。 
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i.

ii.

  
若您已经将 mPaaS 添加至项目中，则无需第一步的处理。
 
 
选择目标 Module，点击 更改。 

  
点击后，对应 module 会添加对应的组件。
 
 
添加成功。 
至此已经将 mPaaS 组件添加到 Module 中，可在此 Module 中调用该组件的能力。
  
mPaaS 会在您的指定的 Module 的 build.gradle 中添加以下内容：
 

基线依赖信息
组件依赖信息
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除了使用 mPaaS 助手，还可以使用 AAR 组件管理，来添加\卸载 mPaaS 组件。详情可
参考 AAR 组件管理。
 

 
  
后续步骤——CPU 架构适配
 
 
mPaaS 仅支持 armeabi 架构，因此需要在工程主 Module 下的 build.gradle 文件中添加以下配置，适配单一
的 armeabi CPU 架构。
 

 
 
选择接入方式
 
 

android {
···
defaultConfig {
···
ndk{
abiFilters 'armeabi'
}
···
}
···
}
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接入方式简介
 
 
接入移动开发平台 mPaaS 有以下三种接入方式。本文将向您介绍这三种接入方式，并给出关于选择接入方式
的建议。
 

原生 AAR 方式
mPaaS Inside 方式
组件化方式（Portal&Bundle）
  

原生 AAR 方式
 
原生 AAR 接入方式 是指采用原生 Android AAR 打包方案，更贴近 Android 开发者的技术栈。开发者无需了
解 mPaaS 相关的打包知识，通过 mPaaS Android Studio 插件，或者直接通过 Maven 的 pom 和 bom，即
可将 mPaaS 集成到开发者的项目中来。该方式降低了开发者的接入成本，能够让开发者更轻松地使用
mPaaS，适合对 组件化（Portal&Bundle）接入方式 没有特别需求，想快速使用 mPaaS 能力的客户。
 

 
mPaaS Inside 方式
 
mPaaS Inside 方式 是 组件化方式 到 原生 AAR 方式 的过度方案。 
mPaaS Inside 方式 与 原生 AAR 方式 相比，在运行时代码层的使用上是一致的。区别在于打包方案不同。
mPaaS Inside 方式 使用 mPaaS gradle 打包插件执行 dex 合并打包，而 原生 AAR 方式 使用 Android 原生
的 AAR 打包方式。如果不是特别需要使用 mPaaS 打包方式，推荐使用上面的 原生 AAR 方式 打包。 
使用 mPaaS Inside 方式，需要引入 mPaaS gradle 打包工具，对 gradle 的版本以及
com.android.tools.build:gradle 版本都有一定的要求。
 

 
组件化方式（Portal&Bundle）
 
组件化方式 是指 mPaaS 基于 OSGi（Open Service Gateway Initiative，开放服务网关倡议）技术将一个
App 划分成业务独立的一个或多个 Bundle 工程以及一个 Portal 工程的框架。mPaaS 会对每个 Bundle 工程
的生命周期和依赖加以管理，使用 Portal 工程把所有的 Bundle 工程包合并成一个可运行的 .apk 包。 
组件化方式 适用于大型多人并行开发项目。如果现有工程需要基于组件化架构对原有项目进行重构，请了解 迁
移原生工程至组件化框架。 
使用 组件化方式，需要引入 mPaaS gradle 打包工具，对 gradle 版本以及com.android.tools.build:gradle
版本有一定的要求。
  
如何选择接入方式
如果使用 mPaaS 需要像使用其他 SDK 一样简单接入并使用，推荐使用 原生 AAR 方式。 

说明：原生 AAR 接入方式从 10.1.68 起开始支持。

说明：mPaaS Inside 的方式从 10.1.60 起开始支持。
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1.

如果使用 mPaaS 来重构您的项目需要引入大规模并行研发的理念，推荐使用 组件化方式 。 
mPaaS Inside 是两者之间的过度方案，无特殊需求，不再推荐。
 
 
 
原生 AAR 方式
 
  
AAR 组件管理
 
  
mPaaS 组件管理工具
 
mPaaS 提供了 Android Studio AAR 组件管理工具，帮助您快速添加/卸载 mPaaS 组件。
 
点击工具栏中的 mPaaS > 原生 AAR 接入 > 组件管理 进入组件管理。
 

  
首次使用需先添加 mPaaS 至项目中
 

若尚未接入 mPaaS，基线选择的对话框如下： 

移动开发平台mPaaS 接入 Android
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2.

1.

点击 OK 后，会将 mPaaS 添加到项目中。
  

组件管理
 

点击 组件管理 菜单，会显示组件管理的面板如下： 
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2.

3.

选定 Module 后点击安装。在指定 Module 中使用对应的 mPaaS 组件。
如果想要卸载组件，只需要把上面的开关状态切换为关即可。
 

  
AAR 添加混淆规则
 
 

 
执行任务生成混淆文件。
  
点击 mPDebugProguardTask（或 mPReleaseProguardTask）。 
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执行完成后，项目中会显示如下内容。
  

 
 
将生成的混淆文件追加到混淆策略中。
  

移动开发平台mPaaS 接入 Android
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在 gradle.properties 中添加 android.enableR8=false。 

 
 

  
隐私权限弹框的使用说明
 
  
背景
 
监管部门要求在用户点击隐私协议弹框中 同意 按钮之前，App 不可以调用相关敏感API。为应对此监管要求
，mPaaS Android 10.1.32.16 以上（32 版本） 和 10.1.60.5 以上（60 版本）的基线提供了支持，请您根据

说明：如果您混淆过程中遇到 transformClassesAndResourcesWithR8ForRelease 卡住，可能和
Google 的 R8 策略有关，建议关闭 R8 后再混淆。
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-

实际情况参考本文档对工程进行改造。
  
使用说明
 
您需要在应用中弹出隐私权限弹窗，并在用户点击同意之后调用框架的接口发送 同意 的广播，框架收到广播后
会完成初始化，还会在 sharedpreference 中记录用户同意的行为，初始化完成时通过回调的方式通知您。您
只有收到回调后，才能正常使用 mPaaS 各组件的能力。
  
操作步骤
 

 
在 meta-data 中配置隐隐私权限弹框的开关。该配置的默认状态是关闭。
 

 
使用以下接口，发送 同意 的广播。 
说明：只有在点击 同意 才发送广播。
 

 
用户是否已经同意隐私权限的使用。
 

 
更新用户同意使用隐私权限的标记，可以方便您在特定的场景下再次弹窗。
 

 
框架初始化完成的回调：
 

使用 QuinoxApplication：需要在 onMPaaSFrameworkInitFinished 之后使用 mpaas 的
能力。 
说明：如果您需要使用热修复功能则必须使用 QuinoxApplication。
 
未使用 QuinoxApplication：需要在 IInitCallback 的 onPostInit 之后使用 mPaaS 的能力
。
 

    <meta-data
android:name="privacy_switcher"
android:value="true"></meta-data>

QuinoxlessPrivacyUtil.sendPrivacyAgreedBroadcast(Context context);

 `QuinoxlessPrivacyUtil.isUserAgreed(Context context);

QuinoxlessPrivacyUtil.setUserAgreedState(Context context, **boolean **agreed);

QuinoxlessFramework.setup(this, new IInitCallback()
{

移动开发平台mPaaS 接入 Android
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1.

2.

3.

4.

 
  
升级 Inside 接入方式为 AAR 接入方式
 
  
简介
 
AAR 接入方式 是指几乎完全采用原生接入的方案。在采用 AAR 接入方式 时，由于对 mPaaS 基线管理的需要
，请使用最新稳定版的 Android Gradle Plugin 和 Gradle Wrapper。建议使用 Android Gradle Plugin 3.5.3
和 Gradle Wrapper 5.6 以上版本，目前稳定版是 Android Gradle Plugin 3.6.x 和 Gradle Wrapper 6.3。
  
删除 Inside 相关配置
 

删除项目工程中的 mpaas_packages.json。
如果之前使用 mPaaS 提供的 Gradle 插件，则需要删除相关配置。 

在项目 根目录 的 build.gradle 中，删除 easyconfig 插件。 

删除 APP 模块中 build.gradle 的如下内容： 

 
在项目工程的各 Module 的 build.grade 中，删除以下插件：
 

 
或者，

@Override
public void onPostInit()
{

}
});

classpath 'com.alipay.android:android-gradle-plugin:3.0.0.6.31' // 删除这行配置信息

classpath 'com.android.boost.easyconfig:easyconfig:2.x.x'

apply plugin: 'com.alipay.portal' // 删除这行

apply plugin: 'com.alipay.apollo.baseline.update'
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使用 AAR 接入
 

将 mPaaS SDK 添加到项目中。
在各个 Module 中添加需要使用的组件。
 

  
移除指定的 mPaaS 库
 
 
在 build.gradle 中使用原生的 gradle 语法—— exclude 来移除指定的 mPaaS 库。由于可能存在 mPaaS 多
个组件引用同一个库的情况，推荐您使用全局配置的方式来移除。例如，移除 mPaaS SDK 中内置的高德 SDK
时，可以参照如下方式：
 

 
 
使用 mPaaS 框架通用组件（非必需）
 
  
关于本文
 
本文档是在 组件化接入方式 转为 原生 AAR 接入方式 的情况下，解决原有的 mPaaS 框架通用组件的适配问题
。若未使用 mPaaS 框架通用组件，可以跳过阅读本文档。
 
为了兼容组件化（路由）的方案，在 10.1.60 及以上基线支持使用 apt 的方式来使用以下 4 个组件：
 

ActivityApplication（Application）
ExternalService（Service）
BroadcastReceiver
Pipeline
 

 
使用组件

apply plugin: 'com.alipay.apollo.baseline.config'

configurations {
all*.exclude group:'com.mpaas.group.amap', module: 'amap-build'
all*.exclude group:'com.alipay.android.phone.thirdparty', module: 'amap3dmap-build'
}

说明：这 4 个组件的使用方式与在组件化接入中的使用方式相同，可点击上方组件名查看详情。
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在 library 和 Application 工程中引入相关的依赖。
 

 
定义上述四个组件时分别加上特定的 Annotation。Annotation 有如下四种:
 

@Application
@Service
@BroadcastReceiver
@Pipeline

 
Annotation 中的参数与 metainfo.xml 定义的相同。例如，使用 @Application 时，只需要采用如
下的方式：
 

  
不使用 library module
 
若不使用 library module，只需要在 APP Module 工程中的任意一个类加上 @MetaInfoApplication 即可。
  
使用 library module
 
若在 library module 工程中定义了上述 4 个组件，则需要执行以下操作：
 

 
在任意类中声明一个 @MetaInfoLibrary，其中的参数传入 library module 的 packageName。例
如：
 

 
在 app module 工程中的任意一个类加上 @MetaInfoApplication，依赖传入 library module 中
生成的 MetaInfoConfig.java。例如：
 

  
混淆相关

implementation 'com.mpaas.mobile:metainfo-annotations:1.3.1'
kapt 'com.mpaas.mobile:metainfo-compiler:1.3.0' // kotlin 的 apt 接入方式
annotationProcessor 'com.mpaas.mobile:metainfo-compiler:1.3.0' // java 的 apt 接入方式

@Application(appId = "123123")
public class MicroApplication extends ActivityApplication {
}

@MetaInfoLibrary(applicationId=BuildConfig.APPLICATION_ID)

@MetaInfoApplication(dependencies={com.mylibrary.MetaInfoConfig.class})
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5.

6.

1.

2.

3.

把相关的类加入混淆的白名单，特别是 com.alipay.mobile.core.impl.MetaInfoConfig。可以使用以下命令：
 

 
 
mPaaS Inside
 
  
接入流程简介
 
 
如果采用 mPaaS inside 接入方式，您需要完成以下通用步骤以完成接入流程：
 

配置开发环境。
在控制台创建应用。
客户端创建新工程或 迁移原生工程至 mPaaS Inside。
管理组件依赖。
引入 mPaaS Inside 框架。
编译打包。
 

  
客户端创建新工程
 
  
关于此任务
 
本文将以 Windows 开发环境为例，引导您在本地创建一个全新 App，并编译打包，最终获得可运行的.apk包
。
  
前置条件
 
您首先需要：
 

配置开发环境
在控制台创建应用
确认您的 SDK 版本 为 10.1.60-beta 或更新。
 

-keep public class com.alipay.mobile.core.impl.MetaInfoConfig
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3.

4.

操作步骤
 
具体创建步骤如下：
 

在 Android Studio 中，点击 File > New > Start a New mPaaS Project 。 

在弹出的窗口中，选择 mPaaS Inside，点击 Next 按钮。 

填写 项目名称（应用名）、Package name（包名）；在 控制台配置文件（JSON）路径选择 中选
择从控制台 代码管理 > 代码配置 中下载到的 .config 配置文件；在 项目文件路径 中选择项目路径
后，点击 Next 按钮。 

选择 mPaaS SDK 版本，并勾选您需要的模块依赖。点击 Finish 按钮。 

说明：您也可以通过点击 控制台配置文件（JSON）路径选择 文本框右侧的 获取配置文件 按钮，快速
访问 mPaaS 控制台下载配置文件。

重要：
请按需勾选模块依赖。具体依赖信息，请参考各组件的接入文档。-

您也可以只选择框架必选依赖。在完成应用创建之后，再参考各组件的接入文档，使用
mPaaS 插件 > 组件管理 功能添加所需依赖。

-
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2.

3.

4.

5.

  
后续步骤
 
您可以参考各组件的接入文档，接入并使用 mPaaS 组件。
  
相关链接
 
mPaaS inside 接入方式 > 简介：介绍 mPaaS inside 工程与 Portal、Bundel 工程的关系 、mPaaS inside 工
程与原生工程的不同之处以及如何 在 mPaas inside 工程中继续使用 Bundle 组件。
 
 
 
迁移原生工程至 mPaaS Inside
 
  
前提条件
 
首先，您需要已经完成以下内容：
 

mPaaS Inside/组件化方式的环境配置
注册阿里云账号
开通 mPaaS 产品
创建 mPaaS 应用
填写配置信息，并上传签名 APK
下载配置到本地
  

操作步骤
 

打开 Android Studio。
点击 mPaaS > 安装 mPaaS Inside 菜单。
在弹出的对话框中，配置 mPaaS Config Location，选择 mPaaS 配置文件的路径，选择完毕后
，其他配置项将自动填写。
点击 Finish 按钮，等待迁移完成。 
说明：若转换失败，一般是因为已有工程中的依赖与 mPaaS SDK 存在冲突，解决方法请参见 解决
依赖冲突。
迁移成功后，您将会看到如下提示。 
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1.

2.

3.

1.

您也可以通过检查 gradle.properties 是否包含quinoxless=true 信息来确认是否迁移成功。
  
管理组件依赖
 
  
升级 IDEA 插件
 

为了更便捷地升级 mPaaS SDK 基线和组件，您需要先升级 mPaaS IDEA 插件至最新版本。
 

在 Android Studio 中选择 Preferences > Plugins。
搜索关键字 mPaaS，在下方结果中找到 mPaaS Android Plugin，并点击其右侧的 Update 进行升
级。
按照提示重启 Android Studio。 

  
管理组件依赖
 
为了使用 mPaaS 组件，您需要在 mPaaS Inside 工程中添加对应组件的依赖。
 

使用 IDEA 插件增删依赖步骤为：
 

在 Android Studio 中选择 mPaaS > 组件管理，如果您此前未使用过 IDEA 插件管理组件依赖，您
会先进入 选择 mPaaS 基线版本 来选择版本。 

说明：如果已是最新版本可跳过此升级。

说明：如果您在创建 mPaaS 工程时已选择过需要使用的组件，您仍可以按照下文步骤增删组件。
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2.

3.

随后您将看到组件列表。 

您可以根据需要增删组件，install 为添加，uninstall 为删除，框架和必备组件无法被删除。
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1.

4.

5.

1.

2.

首次使用插件管理依赖
 
如果您此前未使用过 IDEA 插件管理组件依赖，当您首次使用 组件管理 功能添加完组件后，您还需要检查或修
改以下配置。
 

检查 mPaaS Inside 工程根目录 build.gradle 文件，确保包含以下依赖且不低于以下版本。 

 
检查工程主 module 下的 build.gradle 文件，确保包含以下内容。
 

 
若需要在子 module 中调用 mPaaS 组件 API，则在工程子 module 下的 build.gradle 文件中添加
：
 

如果旧依赖中有为您定制的库，您还需要 添加定制依赖。
如果由于库冲突导致编译失败，您可以 移除 mPaaS 组件单个依赖。
  

升级 SDK 版本
 

在 Android Studio 中选择 mPaaS > 基线升级，您将看到当前 SDK 版本信息。
点击版本下拉框，选择一个新版本，然后点击 OK 按钮，即可升级 mPaaS SDK 版本。 

buildscript {
...
dependencies {
classpath 'com.android.boost.easyconfig:easyconfig:2.3.8'
}
}

apply plugin: 'com.alipay.portal'
portal {
allSlinks true
mergeAssets true
}
apply plugin: 'com.alipay.apollo.baseline.update'
mpaascomponents{
excludeDependencies=[]
}

apply plugin: 'com.alipay.apollo.baseline.update'
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升级单个组件
  
新版
 

在 Android Studio 中选择 mPaaS > 组件升级，您将看到组件列表。
查看组件状态，进行升级操作，若右上角有提示可更新，那么点击之后就能更新了。 
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-

-

-

 
旧版
 

在 Android Studio 中选择 mPaaS > 组件升级，您将看到组件列表。
查看组件状态，进行升级操作。 

若为 最新版，则说明该组件无需升级。
否则说明该组件有新版本。您可以点击状态按钮，升级该组件。 

  
添加定制依赖
 

如果您首次使用 组件管理 管理组件但未升级 SDK，您只需将定制库写在工程主 module 下
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build.gradle 文件中的 dependencies 节点下，例如： 

如果您首次使用 组件管理 管理组件且升级了 SDK，或使用 基线升级 升级了 SDK，您的定制库可能
需要基于新版本重新定制，请 提交工单 或联系 mPaaS 支持人员确认，重新定制或确认无需重新定制
后，您可按照上文添加定制依赖。
 

  
初始化 mPaaS
 
  
关于本文
 
在使用 mPaaS 框架前需要进行一些初始化操作对 Application 对象进行改造。由于使用热修复功能后采取不
同的初始化内容，因此本文将根据是否使用热修复功能分别向您介绍相应的初始化操作。
  
不使用热修复功能
 
不使用 热修复 功能时，只需在 Application 中添加如下代码:
 

 
使用热修复
 
使用 热修复 功能时，还需要完成以下操作。

bundle 'com.alipay.android.phone.mobilesdk:logging-build:2.0.2.180322162837@jar'
manifest 'com.alipay.android.phone.mobilesdk:logging-build:2.0.2.180322162837:AndroidManifest@xml'

@Override
protected void attachBaseContext(Context base) {
super.attachBaseContext(base);
QuinoxlessFramework.setup(this, new IInitCallback() {
@Override
public void onPostInit() {
// 在这里开始使用 mPaaS 功能
}
});
}

@Override
public void onCreate() {
super.onCreate();
QuinoxlessFramework.init();
}
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操作步骤
 

 
在 Application 中添加如下代码:
 

 
使 Application 对象重新继承 QuinoxlessApplicationLike，并注意将此类防混淆。此处以
“MyApplication” 为例。
 

 @Override
protected void attachBaseContext(Context base) {
super.attachBaseContext(base);
QuinoxlessFramework.setup(this, new IInitCallback() {
@Override
public void onPostInit() {
// 在这里开始使用 mPaaS 功能
}
});
}

@Override
public void onCreate() {
super.onCreate();
QuinoxlessFramework.init();
}

 @Keep
public class MyApplication extends QuinoxlessApplicationLike implements
Application.ActivityLifecycleCallbacks {

private static final String TAG = "MyApplication";

@Override
protected void attachBaseContext(Context base) {
super.attachBaseContext(base);

Log.i(TAG, "attacheBaseContext");

}

@Override
public void onCreate() {
super.onCreate();
Log.i(TAG, "onCreate");
registerActivityLifecycleCallbacks(this);
}

@Override
public void onMPaaSFrameworkInitFinished() {
LoggerFactory.getTraceLogger().info(TAG, getProcessName());
}

@Override
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在 AndroidManifest.xml 文件中将 Application 对象指向 mPaaS 提供的Application对象。 将生
成的 “MyApplication” 类添加到 key 为 mpaas.quinoxless.extern.application 的 meta-data
中。示例如下：
 

 
引入 Apache HTTP 客户端。
  
在使用 RPC 或者热修复功能的时候，需要调用到 Apache HTTP 客户端相关的功能。只需在
AndroidManifest.xml 加入如下代码。更多信息，请参见 使用 Apache HTTP 客户端。
 

public void onActivityCreated(Activity activity, Bundle savedInstanceState) {
Log.i(TAG, "onActivityCreated");
}

@Override
public void onActivityStarted(Activity activity) {

}

@Override
public void onActivityResumed(Activity activity) {

}

@Override
public void onActivityPaused(Activity activity) {

}

@Override
public void onActivityStopped(Activity activity) {

}

@Override
public void onActivitySaveInstanceState(Activity activity, Bundle outState) {

}

@Override
public void onActivityDestroyed(Activity activity) {

}}

 <application
android:name="com.alipay.mobile.framework.quinoxless.QuinoxlessApplication" >
<meta-data
android:name="mpaas.quinoxless.extern.application"
android:value="com.mpaas.demo.MyApplication"
/>
</application>
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编译打包
 
 
本文介绍 mPaaS Inside 工程的编译与打包。
  
配置打包插件
 
mPaaS 通过 mPaaS Gradle 插件提供了接近原生的打包方式。mPaaS Gradle 插件有稳定版和测试版
（beta）两种版本。
 

 
基于 Android Gradle Plugin 3.0.1 版本的 mPaaS Gradle 插件是稳定版，但要求使用 4.4 版本的
Gradle。
 

 
基于 Android Gradle Plugin 3.5.3 版本，我们提供了 3.5.x 的版本的mPaaS Gradle 插件，目前最新
的版本是 3.5.0-beta8。
 

  
插件接入
 
如果您使用的是 Android Studio mPaaS 插件创建的新工程，或者是由原生工程转换的工程，那么应该已经执
行了以下步骤，在此只需要进行检查确认。
 

在项目根目录的 build.gradle 中引入这几个插件。 

在主工程中应用插件。 

<uses-library android:name="org.apache.http.legacy" android:required="false"/>

  classpath 'com.alipay.android:android-gradle-plugin:3.0.0.8.3

classpath 'com.alipay.android:android-gradle-plugin:3.5.0-beta8'

说明：请仅在必要的时候使用 beta 版本，并且去除 apply plugin:'com.android.application'。

classpath 'com.android.boost.easyconfig:easyconfig:2.3.0'
classpath 'com.alipay.android:android-gradle-plugin:3.0.0.8.3' //或者beta版本
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在 gradle.properties 文件中有quinoxless=true。
 
 
确保根目录下已经有 mpaas_packages.json 文件。如果没有的话，请使用 Android Studio mPaaS
插件中的 mPaaS > 基线升级 功能安装基线。
 
  

打包
 
您可以直接使用 Android Studio 提供的 Build 按钮直接进行打包，也可以使用 Gradle Wrapper 执行以下命
令采用脚本方式进行打包。
 

 
 
使用外部资源
 
  
使用原生外部资源
 
在 mPaaS Inside 功能提供整合的情况下，您使用资源非常方便，像其他原生工程一样，只用在依赖中引入您
需要的组件。
 

使用的时候，按照原生工程一样即可。
 

apply plugin: 'com.alipay.portal'
apply plugin: 'com.alipay.apollo.baseline.update'
portal {
allSlinks true
mergeAssets true
}
mpaascomponents{
// 如果有不需要的 mpaas bundle，把他们加入到这个数组里
excludeDependencies=[
"com.alipay.android.phone.thirdparty:androidsupport-build"
]
}

./gradlew clean assembleDebug

dependencies {
implementation "com.android.support:appcompat-v7:$support_version"
}

<LinearLayout xmlns:android="http://schemas.android.com/apk/res/android"
xmlns:aui="http://schemas.android.com/apk/res/com.alipay.mobile.antui"
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使用 mPaaS 资源（例如 antui）
 
使用 antui 的时候，您还是需要依照原先提供的方式引用，例如，在xml中使用，需要为 antui 增加前缀。
 

 
 
mPaaS Inside 工程使用 MultiDex 的注意事项
 
  
关于本文
 
MultiDex 是为了解决 Android 5.0 以下 Dex 方法的数量或者类的数量超过 65535 这个问题的方案。在当前
应用功能膨胀的情况下，我们需要对 Dex 做一些规划。由于 mPaaS 接入方式是基于 bundle。在打包的时候
，bundle 会尝试和用户的 Dex 做一次合并，但 mPaaS 会优先保证用户的首个 Dex 的顺序。在这种情况下
，为了接入 mPaaS，请您尽量避免在 Application 中添加过多的逻辑，使得第一个 dex 尽可能的小。您可以
使用 --main-dex-list 参数指定您在第一个 Dex 中的类。如果您的 apk 中第一个 Dex 类过多导致 mPaaS 必
要的几个 bundle 无法合并的话，可能在 Android 5.0 以下的运行时环境中造成无法启动框架
（ClassNotFound 或者 ClassNotDef 等问题）。
  
注意事项
 

android:layout_width="match_parent"
android:layout_height="match_parent"
android:orientation="vertical">

<TextView
android:id="@+id/title_atb"
android:layout_width="match_parent"
android:layout_height="wrap_content" />
</LinearLayout>

<LinearLayout xmlns:android="http://schemas.android.com/apk/res/android"
xmlns:aui="http://schemas.android.com/apk/res/com.alipay.mobile.antui"
android:layout_width="match_parent"
android:layout_height="match_parent"
android:orientation="vertical">

<com.alipay.mobile.antui.basic.AUTitleBar
android:id="@+id/title_atb"
aui:rightIconResid="@com.mpaas.demo.sharedres:drawable/titlebar_right"
android:layout_width="match_parent"
android:layout_height="wrap_content" />
</LinearLayout>
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-

-

接入 mPaaS Inside 的时候，我们已经提供了 MultiDex，因此您可以把官方提供的 MultiDex 从
implementation 中删除。
 

 
同时，建议您在 gradle 中的 android 这个模块下，把 multiDexEnabled true 加上。
 

 
如果您使用了 mPaaS Inside，同时不接入热修复，并且您需要 MultiDex 支持的话，您依旧要在
Application中调用MultiDex.install(this)。
 

如果您使用了热修复，也就是使用了 QuinoxlessApplication，您不需要在代码中显式调用。
 

  
移除指定的 mPaaS 库
 
 
在 build.gradle 中通过 excludeDependencies 来移除指定的 mPaaS 库。通常情况下该节点已在创建或迁移
mPaaS 工程时自动写入，如果在build.gradle未找到相关代码，可手动添加。
 

对于 Inside 工程，请在工程主 Module 的 build.gradle 中指定。
对于 Portal&Bundle 工程，请在 Portal 工程主 Module 的 build.gradle 中指定。
 

例如，在移除 mPaaS SDK 中内置的高德 SDK 时，可以参照如下方式：
 

dependencies{
implementation 'com.android.support:multidex:1.0.3' //删除此行
}

android {
defaultConfig {
multiDexEnabled true
}
}

public class App extends Application() {
public void attachBaseContext(Context context) {
super.attachBaseContext(context);
MultiDex.install(this);
}
}

mpaascomponents {
excludeDependencies = [
"com.mpaas.group.amap:amap-build",
"com.alipay.android.phone.thirdparty:amap3dmap-build"
]
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2.

 
 
组件化接入方式（Portal Bundle）
 
  
接入流程
 
  
接入流程简介
 
如果采用 组件化接入方式，您需要完成以下通用步骤以完成接入流程：
 

配置开发环境。
在控制台创建应用。
客户端创建新工程。
管理组件依赖。
编译打包。
  

客户端创建新工程
  
关于此任务
 
本文将以 Windows 开发环境为例，引导您在本地创建一个全新 App，并编译打包，最终获得可运行的 .apk
包。
  
前置条件
 
您首先需要：
 

配置开发环境
在控制台创建应用
  

创建 Portal
 
如果您需要组件化方案，可以使用 Portal Bundle 方式，您首先需要创建一个 Portal 工程。
 
Portal 一般不包含业务代码，仅仅用于将各 Bundle 合并成一个可运行的 .apk 包。因此在创建 Portal 时，默
认会创建一个后缀名为 Launcher 的 Bundle 工程。

}
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4.

5.

6.

7.

8.

具体创建步骤如下：
 

在 Android Studio 中，点击 File > New > mPaaS Project > Portal Project。 

填写 Application name（应用名，假定为 MPaaSDemo，下同）、Package name（包名）等信
息，然后点击 Next 按钮。
在 mPaaS Config Location 中选择从控制台 代码管理 > 代码配置 中下载到的 .config 配置文件。
然后您将看到解析出来的 App Key、PRC 网关 等信息。点击 Next 按钮。
选择 mPaaS SDK 版本，并勾选您需要的模块依赖。点击 Next 按钮。 

填写 Group Id、Artifact Id、Version 等信息。 

点击 Finish 按钮。稍等片刻，您将看到创建成功的 Portal（MPaaSDemo） 和 Launcher
（MPaaSDemoLauncher） 工程。 

在 Launcher（MPaaSDemoLauncher）工程中，点击 mPaaS > Build，构建 Launcher 工程。
在 Portal（MPaaSDemoPortal）工程中，点击 mPaaS > Build，构建 Portal 工程。构建成功后会
生成.apk包，且会出现安装应用弹出框，您可以将应用安装后进行测试。
  

创建新 Bundle
 
mPaaS 框架支持多 Bundle，您可以在 Android Studio 中，通过 File > New > mPaaS Project > Bundle
Project 创建新 Bundle。创建过程与上文描述类似，不再赘述。
 
关于 Bundle 开发的更多信息，请参见 Bundle 工程。
  
后续步骤
 
您可以参考各组件的接入文档，接入并使用 mPaaS 组件。
  
相关链接
 
组件化接入方式 > 简介：介绍 Portal 和 Bundle 工程的代码结构、编译打包结果以及与原生工程的区别。
  

重要：
请按需勾选模块依赖。具体依赖信息，请参考各组件的接入文档。-

您也可以只选择框架必选依赖。在完成应用创建之后，再参考各组件的接入文档，使用
mPaaS 插件 > 组件管理 功能添加所需依赖。

-

说明：为了快速接入，您可以先忽略更多高级配置。不过如有需要，请参见 Bundle 属性。

说明：在创建 Portal 工程的时候，Android Studio 会自动为其创建一个的 Bundle 工程。该 Bundle
工程的工程名即 Portal 工程的工程名加Launcher 后缀，如MPaaSDemoLauncher。
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管理组件依赖
  
升级 IDEA 插件
 

为了更便捷地升级 mPaaS SDK 基线和组件，您需要先升级 mPaaS IDEA 插件至最新版本：
 

在 Android Studio 中选择 Preferences > Plugins。
在下方 Updates 结果中找到 mPaaS，并点击其右侧的 Update 进行升级。
按照提示重启 Android Studio。 

  
管理组件依赖
 
为了使用 mPaaS 组件，您需要分别在 Portal 和 Bundle 工程中添加对应组件的依赖：
 

在 Portal 工程中添加，将确保相应依赖在打包时打入您的 APK 。
在 Bundle 工程中添加，将确保您能在 Bundle 工程中调用对应组件的 API 。
对于单 Portal 工程模式，您只需在 Portal 工程中添加。
如果您在创建 mPaaS 工程时已选择过需要使用的组件，您仍可以按照下文步骤增删组件。
 

使用 IDEA 插件增删依赖步骤为：
 

在 Android Studio 中选择 mPaaS > 组件管理，如果您此前未使用过 IDEA 插件管理组件依赖，您
会先进入 选择 mPaaS 基线版本 来选择版本： 

说明：如果已是最新版本可跳过此升级。
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3.

随后您将看到组件列表： 

您可以根据需要增删组件，install 为添加，uninstall 为删除，框架和必备组件无法被删除。
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首次使用插件管理依赖
 
如果您此前未使用过 IDEA 插件管理组件依赖，当您首次使用 组件管理 功能添加完组件后，您还需要检查或修
改以下配置：
 

检查 Portal/Bundle 工程根目录 build.gradle 文件，确保包含以下依赖且不低于以下版本： 

检查 Portal 工程主 module 下的 build.gradle 文件，确保包含以下内容： 

删除旧依赖： 

对于 Portal + Bundle 模式，您需要在 Portal 工程主 module 下的 build.gradle 文件中
删除 dependencies 节点下 mPaaS 组件相关依赖（mpaas-baseresjar 除外）。
对于单 Portal 工程模式，您需要在主 module 下的 build.gradle 文件中删除以下内容： 

并删除工程根目录下的 mpaas_bundles.gradle 和 mpaas_apis.gradle 文件，但需要注意
，删除 mpaas_apis.gradle 文件可能导致编译失败，您需要按照下文在子 module 中修改
配置。

如果您需要在子 module 中调用 mPaaS 组件 API： 
对于 Portal + Bundle 模式的工程，您需要在 Bundle 工程子 module 下的 build.gradle
文件中添加： 

buildscript {
...
dependencies {
classpath 'com.android.boost.easyconfig:easyconfig:2.1.6'
}
}

apply plugin: 'com.alipay.portal'
portal {
allSlinks true
mergeAssets true
}
apply plugin: 'com.alipay.apollo.baseline.update'
mpaascomponents{
excludeDependencies=[]
}

重要：强烈建议您在删除以下内容前先进行备份。

apply from: rootProject.getRootDir().getAbsolutePath() + "/mpaas_bundles.gradle"
apply from: rootProject.getRootDir().getAbsolutePath() + "/mpaas_apis.gradle"

apply plugin: 'com.alipay.apollo.baseline.update'
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5.

6.

1.

2.

对于单 Portal 工程模式，您需要在子 module 下的 build.gradle 文件中删除： 

并添加： 

如果旧依赖中有为您定制的库，您还需要 添加定制依赖。
如果由于库冲突导致编译失败，您可以 移除 mPaaS 组件单个依赖。
  

升级 SDK 版本
 

在 Android Studio 中选择 mPaaS > 基线升级，您将看到当前 SDK 版本信息。
点击版本下拉框，选择一个新版本，然后点击 OK 按钮，即可升级 mPaaS SDK 版本。 

  
升级单个组件
  
新版

apply from: rootProject.getRootDir().getAbsolutePath() + "/mpaas_apis.gradle"

apply plugin: 'com.alipay.apollo.baseline.update'

移动开发平台mPaaS 接入 Android

44



1.

2.

1.

2.

-
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在 Android Studio 中选择 mPaaS > 组件升级，您将看到组件列表。
查看组件状态，进行升级操作，若右上角有提示可更新，那么点击之后就能更新了。 

  
旧版
 

在 Android Studio 中选择 mPaaS > 组件升级，您将看到组件列表。
查看组件状态，进行升级操作： 

若为 最新版，则说明该组件无需升级。
否则说明该组件有新版本。您可以点击状态按钮，升级该组件。 

  
添加定制依赖
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如果您首次使用 组件管理 管理组件但未升级 SDK，您只需将定制库写在 Portal 工程主 module 下
build.gradle 文件中的 dependencies 节点下，例如： 

如果您首次使用 组件管理 管理组件且升级了 SDK，或使用 基线升级 升级了 SDK，您的定制库可能
需要基于新版本重新定制，请 提交工单 或联系 mPaaS 支持人员确认，重新定制或确认无需重新定制
后，您可按照上文添加定制依赖。
  

编译打包
 
本文介绍组件化工程的编译与打包功能。
  
操作方法
 
请使用 mPaaS Android Studio Plugin 提供的打包功能：
 

Build：打包。
Build Settings：打包配置。
  

Build
 
Build 执行 gradle 命令，用于编译打包。更多信息，参见 Build Settings > Custom Command。
  
Build Settings
 
Build Settings 用于自定义打包参数。
  
Custom Command
 
当勾选了 打debug包 时，Build 默认执行命令 gradle clean buildDebug；否则默认执行命令 gradle clean
buildRelease。 
您可以在此自定义打包命令。此时，打 debug 包 勾选框将失效。
  
Custom Params
 
默认为 --stacktrace --info -Plog=true。更多信息，参见 Gradle Command-Line Interface。
 
 
 
注册通用组件
 

bundle 'com.alipay.android.phone.mobilesdk:logging-build:2.0.2.180322162837@jar'
manifest 'com.alipay.android.phone.mobilesdk:logging-build:2.0.2.180322162837:AndroidManifest@xml'
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简介
 
模块化是 mPaaS 框架的设计原则之一，业务模块的低耦合与高内聚有利于业务的扩展和维护。
 
业务模块以 Bundle 的形式存在互不影响，但 Bundle 之间会存在一些关联性，比如跳转到另一个 Bundle 界
面，调用另一个 Bundle 中的接口，或者Bundle 中的一些操作需要在初始化的过程中完成等。
 
因此，mPaaS 设计了 metainfo 通用组件注册机制，各个 Bundle 将需要注册的组件在 metainfo.xml 中声明
。
 
框架目前支持以下组件:
 

ActivityApplication（Application）
ExternalService（Service）
BroadcastReceiver
Pipeline
 

metainfo.xml 格式如下：
 

 
Application 组件
 
ActivityApplication 是 mPaaS 框架设计的组件，起到 Activity 容器的角色。ActivityApplication 组件的主要
作用在于管理和组织各个 Activity，专门用于解决跳转到另一个Bundle 界面的问题。因而，调用方只需关心业
务方在框架中注册的 ActivityApplication 信息以及约定的参数。
  
关于此任务
 
ActivityApplication 的创建、销毁等一系列逻辑完全由 mPaaS 框架来管理。业务方只需要处理其收到的参数
并管理自己业务下的 Activity，这样业务方和调用方之间被有效的隔离开来。业务方和调用方只需要协调调用
的参数，使得依赖更加轻量。
 
基于 mPaaS 框架开发的 Android 客户端应用，Activity 须继承自 BaseActivity 或
BaseFragmentActivity，以便能够被 ActivityApplication 类所管理。

<?xml version="1.0" encoding="UTF-8"?>
<metainfo>
<broadcastReceiver>
<className>com.mpaas.demo.broadcastreceiver.TestBroadcastReceiver</className>
<action>com.mpaas.demo.broadcastreceiver.ACTION_TEST</action>
</broadcastReceiver>
<application>
<className>com.mpaas.demo.activityapplication.MicroAppEntry</className>
<appId>33330007</appId>
</application>
</metainfo>
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1.

提示：您可以下载代码示例，示例中包含跳转到另一个 Bundle 的 Activity。有关下载地址、使用方法及注意
事项，查看 获取代码示例。
  
操作步骤
 

在工程的主 module 中创建 metainfo.xml 文件，放在如下图位置： 

 
在 metainfo.xml 中写入如下的配置，其中：
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- className 配置的类名用于提供跳转的类名称和定义各阶段的行为。具体类的定义，参见
步骤 3 的代码。框架通过 className 定义的名称加载相应的类，所以该类一定不能被混淆
，需要在混淆文件中保留。
 
appId：业务的唯一标识。业务方只需要知道该业务的 appId 就能完成跳转。appId 与
ActivityApplication 的映射由框架层处理。
 

 
如果 metainfo 通过 className 指定的类只是完成简单的跳转，使用以下代码实现：
 

<?xml version="1.0" encoding="UTF-8"?>
<metainfo>
<application>
<className>com.mpaas.demo.hotpatch.HotpatchMicroApp</className>
<appId>33330002</appId>
</application>
</metainfo>

 /**
* 场景一：
* 若只可能会跳转到某一个Activity界面，那么需要重载getEntryClassName和onRestart，前者返回Activity的
classname，后者需要调用getMicroApplicationContext().startActivity(this, getEntryClassName());
* 场景二：
* 若需要根据需求跳转到不同的Activity界面那么需要重载onStart和onRestart，根据bundle中的参数跳转到指定的
界面
* Created by mengfei on 2018/7/23.
*/
public class MicroAppEntry extends ActivityApplication {

@Override
public String getEntryClassName() {
//场景一：只可能跳转到某一个Activity在此返回classname即可
//return MainActivity.class.getName();
//场景二：根据参数跳转到某一界面，需要返回null
return null;
}

/**
* Application被创建时被调用，实现类可以在这里做些初始化的工作
*
* @param bundle
*/
@Override
protected void onCreate(Bundle bundle) {
doStartApp(bundle);
}

/**
* 启动Application时被调用
* 如果Application还没有被创建，会先去执行create方法，然后再执行onStart()回调
*/
@Override
protected void onStart() {
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4. 作为调用者，您需要通过框架封装的 MicroApplicationContext 中提供的接口进行跳转。curId 参
数也可以传 null： 

}

/**
* 当Application被销毁时，调用此回调
*
* @param bundle
*/
@Override
protected void onDestroy(Bundle bundle) {

}

/**
* 启动Application时，如果Application已经被start过了，则不调用onStart()而是调用onRestart()回调
*
* @param bundle
*/
@Override
protected void onRestart(Bundle bundle) {
//针对场景一：需要在此调用getMicroApplicationContext().startActivity(this, getEntryClassName());
doStartApp(bundle);
}

/**
* 当一个新的Application被start时，当前的Application将被暂停，此方法被回调
*/
@Override
protected void onStop() {

}

private void doStartApp(Bundle bundle) {
String dest = bundle.getString("dest");
if ("main".equals(dest)) {
Context ctx = LauncherApplicationAgent.getInstance().getApplicationContext();
ctx.startActivity(new Intent(ctx, MainActivity.class));
} else if ("second".equals(dest)) {
Context ctx = LauncherApplicationAgent.getInstance().getApplicationContext();
ctx.startActivity(new Intent(ctx, SecondActivity.class));
}
}
}

 // 获取 MicroApplicationContext 对象：
MicroApplicationContext context = MPFramework.getMicroApplicationContext();
String curId = "";
ActivityApplication curApp = context.getTopApplication();
if (null != curApp) {
curId = curApp.getAppId();
}
String appId = "目标ApplicationActivity的id";

移动开发平台mPaaS 接入 Android

50



-

-

  
Service 组件
 
mPaaS 设计了 Service 组件解决跨 Bundle 调用接口。Service 组件用于将一些逻辑以服务的形式提供出来
，供其他模块使用。
  
关于此任务
 
Service 组件的特点如下：
 

没有用户界面的限制。
在设计上，遵循接口与实现分离。
 

原则上只有接口类对调用者可见，所以接口类应定义在接口 module 中（在生成 Bundle project 时，默认会
生成一个接口 module，名字是 api），实现定义在主 module 中。
 
外部调用都通过 MicroApplicationContext 的 findServiceByInterface 接口，通过interfaceName 获取相应
的服务。对于 Bundle 使用来说，只暴露服务抽象接口类，即 interfaceName 中定义的类，抽象接口类会定义
在接口包中。
 
提示：您可以下载代码示例，示例中包含调用另一个 Bundle 的接口示例。有关下载地址、使用方法及注意事
项，查看 获取代码示例。
  
操作步骤
 
通过以下步骤注册 Service 组件：
 

 
定义 metainfo.xml 位置，如下图所示：
  

Bundle bundle = new Bundle(); // 附加参数，也可以不传
context.startApp(curId, appId, bundle);

移动开发平台mPaaS 接入 Android

51



 
 
在 metainfo.xml 中写入如下的配置。框架将 interfaceName 作为 key，className 作为
value，记录两者的映射关系。其中，className 为具体接口的实现类， interfaceName 为抽象接
口类：
 

<metainfo>
<service>
<className>com.mpaas.cq.bundleb.MyServiceImpl</className>
<interfaceName>com.mpaas.cq.bundleb.api.MyService</interfaceName>
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抽象接口类定义如下：
 

 
接口类实现定义如下：
 

外部调用方式如下： 

  
BroadcastReceiver 组件
 
BroadcastReceiver 是 android.content.BroadcastReceiver 的封装，但区别在于 mPaaS 框架采用了
android.support.v4.content.LocalBroadcastManager 来注册和反注册 BroadcastReciever，因此，这些广
播仅用于当前应用程序内部，除此之外，mPaas框架内部内置了一系列的广播事件，供使用者监听。
  
关于此任务
 
您可以下载包含该通用组件的代码示例。有关下载地址、使用方法及注意事项，查看 获取代码示例。

<isLazy>true</isLazy>
</service>
</metainfo>

public abstract class MyService extends ExternalService {
public abstract String funA();
}

public class MyServiceImpl extends MyService {
@Override
public String funA() {
return "这是 BundleB 提供的接口 by service";
}

@Override
protected void onCreate(Bundle bundle) {

}

@Override
protected void onDestroy(Bundle bundle) {

}
}

MyService myservice =
LauncherApplicationAgent.getInstance().getMicroApplicationContext().findServiceByInterface(MyService.
class.getName());
myservice.funA();
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mPaaS内置广播事件
 
mPaaS 定义了多种广播事件，主要用于监听当前应用的状态，注册监听与原生开发没有任何区别，但有一点需
要特别注意，这些状态只有在主进程才能监听到。示例代码如下：
 

 
内置的广播事件如下：
 

 
自定义广播事件
 

 
定义 metainfo.xml 位置，如下图所示：
  

public interface MsgCodeConstants {
String FRAMEWORK_ACTIVITY_CREATE = "com.alipay.mobile.framework.ACTIVITY_CREATE";
String FRAMEWORK_ACTIVITY_RESUME = "com.alipay.mobile.framework.ACTIVITY_RESUME";
String FRAMEWORK_ACTIVITY_PAUSE = "com.alipay.mobile.framework.ACTIVITY_PAUSE";
// 用户离开的广播，压后台广播
String FRAMEWORK_ACTIVITY_USERLEAVEHINT = "com.alipay.mobile.framework.USERLEAVEHINT";
// 所有 Activity 全都 Stop 的广播，可能代表压后台，但目前没有用相同的判断逻辑
String FRAMEWORK_ACTIVITY_ALL_STOPPED = "com.alipay.mobile.framework.ACTIVITY_ALL_STOPPED";
String FRAMEWORK_WINDOW_FOCUS_CHANGED = "com.alipay.mobile.framework.WINDOW_FOCUS_CHANGED";
String FRAMEWORK_ACTIVITY_DESTROY = "com.alipay.mobile.framework.ACTIVITY_DESTROY";
String FRAMEWORK_ACTIVITY_START = "com.alipay.mobile.framework.ACTIVITY_START";
String FRAMEWORK_ACTIVITY_DATA = "com.alipay.mobile.framework.ACTIVITY_DATA";
String FRAMEWORK_APP_DATA = "com.alipay.mobile.framework.APP_DATA";
String FRAMEWORK_IS_TINY_APP = "com.alipay.mobile.framework.IS_TINY_APP";
String FRAMEWORK_IS_RN_APP = "com.alipay.mobile.framework.IS_RN_APP";
// 用户回到前台的广播
String FRAMEWORK_BROUGHT_TO_FOREGROUND = "com.alipay.mobile.framework.BROUGHT_TO_FOREGROUND";
}
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在 metainfo.xml 中写入如下配置：
 

 <?xml version="1.0" encoding="UTF-8"?>
<metainfo>
<broadcastReceiver>
<className>com.mpaas.demo.broadcastreceiver.TestBroadcastReceiver</className>
<action>com.mpaas.demo.broadcastreceiver.ACTION_TEST</action>
</broadcastReceiver>
</metainfo>
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1.

自定义 Receiver 实现
 

 
发送广播
 

  
Pipeline 组件
 
mPaaS 框架有一个比较明显的启动过程，Pipeline 机制允许业务线将自己的运行逻辑封装成 Runnable 放到
Pipeline。框架在适当的阶段启动适当的 Pipeline。
 
以下为定义的 Pipeline 时机：
 

com.alipay.mobile.framework.INITED: 框架初始化完成。进程在后台启动，框架也会初始化。
com.alipay.mobile.client.STARTED: 客户端开始启动。必须等到界面出现，例如，欢迎界面。
com.alipay.mobile.TASK_SCHEDULE_SERVICE_IDLE_TASK：优先级最低，当没有其他高优化级的
操作时才会得到执行
 

因为 Pipeline 的调用是由框架触发，使用者只需要在 metainfo 里指定相应的时机。
  
关于此任务
 
您可以下载包含该通用组件的代码示例。有关下载地址、使用方法及注意事项，查看 获取代码示例。
  
操作步骤
 

定义 metainfo.xml 位置，如下图所示： 

public class TestBroadcastReceiver extends BroadcastReceiver {
private static final String ACTION_TEST = "com.mpaas.demo.broadcastreceiver.ACTION_TEST";

@Override
public void onReceive(Context context, Intent intent) {
String action = intent.getAction();
if (ACTION_TEST.equals(action)) {
//TODO
}
}
}

LocalBroadcastManager.getInstance(LauncherApplicationAgent.getInstance().getApplicationContext()).s
endBroadcast(new Intent("com.mpaas.demo.broadcastreceiver.ACTION_TEST"));

移动开发平台mPaaS 接入 Android

56



 
在 metainfo.xml 中写入如下的配置：
 

 <?xml version="1.0" encoding="UTF-8"?>
<metainfo>
<valve>
<className>com.mpaas.demo.pipeline.TestPipeLine</className>
<!--pipelineName就是用于指定执行所在的阶段-->
<pipelineName>com.alipay.mobile.client.STARTED</pipelineName>
<threadName>com.mpaas.demo.pipeline.TestPipeLine</threadName>
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实现 Pipeline： 

 
  
使用 Material Design
 
  
配置工程
  
关于此任务
 
由于 mPaaS 框架的特殊性，若直接在项目中引入 AppCompat 相关库，编译时会报错，提示资源找不到。为
了解决该问题，mPaaS 提供了自定义的 AppCompat 库。要使用 mPaaS 自定义的 AppCompat 库，首先要
配置 Portal 工程和 Bundle 工程。
 
mPaaS AppCompat 库基于原生 Android 23 版本开发，包含以下组件：
 

appcompat
animated-vector-drawable
cardview
design
recyclerview
support-vector-drawable
 

由于该自定义的 AppCompat 库是基于原生 Android 23 版本编译，和原生并无区别，只是解决了引入原生库
的一系列编译问题。
 
使用资源的情况主要包括 使用另一个 Bundle 中的资源 、对外提供资源、在 AndroidManifest 中使用自定义
资源。由于 mPaaS 框架的特殊性，您需要了解使用资源不同情况下的注意事项。要了解具体内容，查看 使用
资源。

<!--weight指定了操作的优化级，值越小，代表越会优先得到执行-->
<weight>10</weight>
</valve>
</metainfo>

 public class TestPipeLine implements Runnable {
@Override
public void run() {
PreferenceManager.getDefaultSharedPreferences(LauncherApplicationAgent.getInstance().getApplicatio
nContext()).edit().putString(Constants.KEY_PIPELINE_RUN_TIMESTAMP, "Pipeline running timestamp: " +
System.currentTimeMillis()).apply();
}
}
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操作步骤
  
1. 配置 Portal 工程
 
在调用 mPaaS AppCompat 库前，完成以下操作配置 Portal 工程：
 

运行以下命令将 Gradle 打包插件（Alipay Plugin for Gradle）版本替换为以下版本： 

移除 Gradle 脚本中原先依赖的 AppCompat 库。
在 Gradle 脚本中添加以下 AppCompat 依赖： 

配置完成后，为了让 Bundle 工程调用 AppCompat 组件，同步 Portal 工程。
  

2. 配置 Bundle 工程
 

在需要使用 AppCompat 组件的 Bundle 工程中，将 Gradle 打包插件（Alipay Plugin for
Gradle）修改为以下版本： 

根据您使用组件的情况，选择需要依赖的子组件。以下为添加 recyclerview 的示例语句： 

  
使用资源
 
Material Design 常见的资源包括 String、Color、Style 等。使用资源的情况主要包括：
 

检测 Package ID 是否重复
使用另一个 Bundle 中的资源
对外提供资源
在 AndroidManifest 中使用自定义资源
  

检测 Package ID 是否重复
 
如果按照本文的说明使用资源时，出现资源找不到的情况，您需要查看 Package ID 是否重复。Package ID 定

classpath 'com.alipay.android:android-gradle-plugin:3.0.0.8.3'

bundle 'com.mpaas.android.res.base:mpaas-baseresjar:1.0.0.180626203034@jar'
manifest 'com.mpaas.android.res.base:mpaas-baseresjar:1.0.0.180626203034:AndroidManifest@xml'

classpath 'com.alipay.android:android-gradle-plugin:3.0.0.8.3'

provided'com.mpaas.android.res.base:mpaas-baseresjar:1.0.0.180626203034:recyclerview@jar'
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义在 build.gradle 中，其 ID 值与生成的资源 ID 有关。重复定义 Package ID 会导致资源找不到的情况。
 
您可以通过以下两种方式检测 Package ID 是否重复：
  
方式一：通过 gradle task 自动检测
 
前置条件
 
android-gradle-plugin 的版本号为 3.0.0.8.3 及以上。如：
 

 
检测步骤
 

在 Portal 工程根目录下，执行以下命令： 
Windows 系统：执行 gradlew.bat checkBundleIds。
其它操作系统：执行 gradlew checkBundleIds。

检查输出结果： 
若输出结果包含 No duplicate bundle ids found，说明 Package ID 没有重复。
若输出结果包含 There are duplicate bundle ids，说明 Package ID 有重复。您可以根据
输出结果进一步判断具体是哪些 Package ID 重复。

  
方式二：手动检测
 
手动检测适用于任何情况，具体步骤如下：
 

 
在 Portal 工程以下位置打开 bundles.csv 纯文本文件。
  

classpath 'com.alipay.android:android-gradle-plugin:3.0.0.8.3'
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2.

 
将 PackageId 列进行排序，查看有无重复的 Package ID；确保没有重复的 Package ID 后再重新编
译。
  

使用另一个 Bundle 中的资源
  
场景示例
 
使用 mpaas-baseresjar 中的资源属于该情况。在使用另一个 Bundle 中的资源时，必须要加上资源的命名空
间。命名空间为资源所在 Bundle 的 applicationID，构建 release 包时可能会出现如下图的错误：
 

  
解决方法
 
在 build.gradle 下配置 lintOptions，配置方法如下图所示：
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只要引用该 Bundle 中的资源（包括在 layout 中引用、在自定义 style 中引用等），就必须加入命名空间作为
前缀。否则，会出现资源找不到的编译错误。
  
代码示例：在 layout 中引用
 
以在 layout 中引用另一个 Bundle 中的资源为例，使用的代码示例如下所示：
 

<?xml version="1.0" encoding="utf-8"?>
<android.support.design.widget.CoordinatorLayout xmlns:android="http://schemas.android.com/apk/res/android"
xmlns:app="http://schemas.android.com/apk/res/com.mpaas.android.res.base"
xmlns:tools="http://schemas.android.com/tools"
android:layout_width="match_parent"
android:layout_height="match_parent"
android:fitsSystemWindows="true">

<android.support.design.widget.AppBarLayout
android:id="@+id/app_bar_scrolling"
android:layout_width="match_parent"
android:layout_height="@dimen/app_bar_height_image_view"
android:fitsSystemWindows="true"
android:theme="@style/AppTheme.AppBarOverlay"
android:background="@color/blue">

<android.support.design.widget.CollapsingToolbarLayout
android:id="@+id/collapsing_toolbar_layout"
android:layout_width="match_parent"
android:layout_height="match_parent"
android:fitsSystemWindows="true"
app:contentScrim="?com.mpaas.android.res.base:attr/colorPrimary"
app:layout_scrollFlags="scroll|exitUntilCollapsed">

<ImageView
android:id="@+id/image_scrolling_top"
android:layout_width="match_parent"
android:layout_height="match_parent"
android:fitsSystemWindows="true"
android:scaleType="fitXY"
android:src="@drawable/material_design_3"
app:layout_collapseMode="parallax" />
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1.

代码示例：在自定义 style 中引用
 
以在自定义 style 中使用另一个 Bundle 中的资源为例，使用的代码示例如下所示：
 

 
对外提供资源
 

配置 Portal 工程。在 Portal 中引入资源 Bundle 的信息： 

 
定义资源。完成以下步骤定义资源，以使得资源可被其他的 Bundle 或者 Portal 引用：
 

 
将需要对外提供的资源 id 定义在 public.xml 中，以达到固定资源 id 的目的。该能力由

<android.support.v7.widget.Toolbar
android:id="@+id/toolbar"
android:layout_width="match_parent"
android:layout_height="?com.mpaas.android.res.base:attr/actionBarSize"
app:layout_collapseMode="pin"
app:popupTheme="@style/AppTheme.PopupOverlay" />

</android.support.design.widget.CollapsingToolbarLayout>
</android.support.design.widget.AppBarLayout>

<android.support.design.widget.FloatingActionButton
android:id="@+id/fab_scrolling"
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_margin="@dimen/big_activity_fab_margin"
android:src="@drawable/ic_share_white_24dp"
app:layout_anchor="@id/app_bar_scrolling"
app:layout_anchorGravity="bottom|end" />

<include layout="@layout/content_scrolling" />

</android.support.design.widget.CoordinatorLayout>

    <style name="AppTheme" parent="@com.mpaas.android.res.base:style/Theme.AppCompat.NoActionBar">
<!-- Customize your theme here. -->
<item name="com.mpaas.android.res.base:colorPrimary">@color/colorPrimary</item>
<item name="com.mpaas.android.res.base:colorPrimaryDark">@color/colorPrimaryDark</item>
<item name="com.mpaas.android.res.base:colorAccent">@color/colorAccent</item>
</style>

// 引入提供资源的 bundle
bundle "com.mpaas.demo.materialdesign:materialdesign-build:1.0-SNAPSHOT:raw@jar"
manifest "com.mpaas.demo.materialdesign:materialdesign-build:1.0-SNAPSHOT:AndroidManifest@xml"
// 为了在编译时能找到资源，还需要 provided 该 bundle 的 jar 包
provided 'com.mpaas.demo.materialdesign:materialdesign-build:1.0-SNAPSHOT:raw@jar'
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ii.

-

-

Android 提供。资源 id 值可以从 R.java 中拷贝，示例代码如下：
 

外部在使用时，在资源前加上包名作为前缀。具体内容，参见 使用另一个 Bundle 中的资
源。

  
在 AndroidManifest 中使用自定义资源
 
如果您在 Bundle 工程的 AndroidManifest 定义了主题，如下代码所示：
 

则您需要：
 

在 Portal 工程的主工程路径下添加 res_slinks 文件，并且将 Bundle 名，逐行添加到 res_slinks 文件
中。
同时在 build.gradle 中去掉该 Bundle 的 manifest依赖 。如下代码所示： 

 
  

<?xml version="1.0" encoding="utf-8"?>
<resources>
<public name="AppTheme" id="0x1f030000" type="style" />
<public name="AppTheme.AppBarOverlay" id="0x1f030001" type="style" />
<public name="AppTheme.NoActionBar" id="0x1f030002" type="style" />
<public name="AppTheme.NoActionBar.StatusBar" id="0x1f030003" type="style" />
<public name="AppTheme.PopupOverlay" id="0x1f030004" type="style" />
<public name="DialogFullscreen" id="0x1f030005" type="style" />
<public name="DialogFullscreenWithTitle" id="0x1f030006" type="style" />

<public name="title_activity_login" id="0x1f0c0081" type="string"/>
<public name="title_activity_recycler_view" id="0x1f0c0082" type="string"/>
<public name="title_activity_share_view" id="0x1f0c0085" type="string"/>
<public name="title_activity_scrolling" id="0x1f0c0083" type="string"/>
<public name="title_activity_settings" id="0x1f0c0084" type="string"/>
<public name="title_activity_about" id="0x1f0c007f" type="string"/>
<public name="activity_donate" id="0x1f0c000e" type="string" />
<public name="activity_my_apps" id="0x1f0c000f" type="string"/>

</resources>

<activity
android:name=".activity.MainActivity"
android:launchMode="singleTop"
android:theme="@com.mpaas.demo.materialdesign:style/AppTheme.NoActionBar"
android:windowSoftInputMode="stateHidden|stateUnchanged">
</activity>

manifest 'com.mpaas.demo.materialdesign:materialdesign-build:1.0.0:AndroidManifest@xml'
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加载框架与定制
 
 
mPaaS Android 框架提供了一整套的加载逻辑。基于此框架，研发团队可以进行多业务线开发。本文描述框架
的启动流程以及如何在框架下添加自己的代码以对接启动。
  
启动流程
  
Application
 
传统 Android apk 运行时首先加载 AndroidManifest 文件 application 节点中 android:name 配置的
Application。
 
由于 mPaaS Android 框架重写了加载流程， android:name 中配置 mPaaS Android 框架的
com.alipay.mobile.quinox.LauncherApplication 类。
 

 
启动页
 
由于框架加载 bundle 可能会比较耗时，因此需要一个启动页等待框架启动完成之后再跳转到程序主页，所以
在 AndroidManifest 文件中配置了框架提供的 com.alipay.mobile.quinox.LauncherActivity 应用启动页。
 
配置如下：
 

为方便开发人员对启动过程的理解，也为了避免启动过程被误改误删、被干扰，mPaaS 的启动过程被适度封装

<application
android:name="com.alipay.mobile.quinox.LauncherApplication"
android:allowBackup="true"
android:debuggable="true"
android:hardwareAccelerated="false"
android:icon="@drawable/appicon"
android:label="@string/name"
android:theme="@style/AppThemeNew" >
</application>

<activity
android:name="com.alipay.mobile.quinox.LauncherActivity"
android:configChanges="orientation | keyboardHidden | navigation"
android:screenOrientation="portrait"
android:windowSoftInputMode="stateAlwaysHidden">
<intent-filter>
<action android:name="android.intent.action.MAIN" />
<category android:name="android.intent.category.LAUNCHER" />
</intent-filter>
</activity>
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1.

2.

3.

。因此，上述的 LauncherApplication 和 LauncherActivity 对开发人员完全不可见。
 
为了让客户端 App 在启动过程中实现自身的初始化逻辑，mPaaS 设计了 LauncherApplicationAgent 和
LauncherActivityAgent 代理。作为开发人员，您可以通过继承这两个类，在相应的回调中实现自身的初始化
逻辑。当您在 bundle 工程中定义了这两个类时，在使用 ProGuard 进行代码混淆的时候则需要对这两个类进
行防混淆设置，详情请参见 混淆 Android 文件。
  
启动流程图
 
mPaaS Android 框架加载流程如下：

 
框架启动后主线程会创建启动页 LauncherActivity ，然后回调 LauncherActivityAgent 的preInit
方法。
框架进行 multidex。过程中会回调 LauncherApplicationAgent 的 preInit 方法，读取当前 .apk 中
每个 bundle 的描述文件，并对每个 bundle 创建对应的类加载器，加载其中的资源文件。
初始化完成后，回调 LauncherActivityAgent 和 LauncherApplicationAgent 的 postInit 方法。
  

定制
 
实际上，框架已在 Launcher 工程中自动创建了两个类 MockLauncherApplicationAgent 和
MockLauncherActivityAgent 继承了 LauncherApplicationAgent 和 LauncherActivityAgent 这两个回调接
口。在框架的初始化过程中，它们分别在 LauncherAppliction 和 LauncherActivity 中被调用。
 
在 Portal 的 AndroidManifest.xml 中配置如下。开发人员也可在 Bundle 中自行实现这两个代理类，在以上
配置中修改对应 meta-data 的 value 值：
 

     <application
android:name="com.alipay.mobile.quinox.LauncherApplication" >

<!-- Application 的回调配置 -->
<meta-data
android:name="agent.application"
android:value="com.mpaas.demo.launcher.framework.MockLauncherApplicationAgent"/>

<!-- Activity 的回调配置 -->
<meta-data
android:name="agent.activity"
android:value="com.mpaas.demo.launcher.framework.MockLauncherActivityAgent"/>
<!-- 启动页的布局配置 -->
<meta-data
android:name="agent.activity.layout"
android:value="layout_splash"/>
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代理类
 
agent.application 配置的是启动过程代理 ApplicationAgent，如下所示：
 

客户端 App 可以在 LauncherApplicationAgent 的实现类中，进行一些 Application 级别的初始化工作。
preInit() 回调发生在框架初始化之前，因此不要在这里调用框架（MicroApplicationContext）的相关接口。
而 postInit() 回调发生在框架初始化完成之后，是可以使用的。
 
agent.activity 配置的是启动 Activity 的代理，如下所示：
 

同上述的 LauncherApplicationAgent 类似，LauncherActivityAgent 的两个回调也分别发生在框架初始化之
前和之后，使用方法也类似。
  
修改启动页布局
 
在 Portal 的 AndroidManifest.xml 中还配置了启动页的布局文件，如下所示：

</application>

public class MockLauncherApplicationAgent extends LauncherApplicationAgent {
@Override
protected void preInit() {
super.preInit();
//框架初始化前
}

@Override
protected void postInit() {
super.postInit();
//框架初始化后
}
}

public class MockLauncherActivityAgent extends LauncherActivityAgent {

@Override
public void preInit(Activity activity) {
super.preInit(activity);
//Launcher Activity 启动前
}

@Override
public void postInit(final Activity activity) {
super.postInit(activity);
//Launcher Activity 启动后
跳转程序首页的逻辑
startActivity(activity,YOUR_ACTIVITY);
}
}

移动开发平台mPaaS 接入 Android

67



-

修改 value 值为自定义的布局文件名。
 
注意：需要把布局文件和引用的相关资源放置在 Portal 工程里。
  
相关链接
 
代码示例
 
 
 
管理 Gradle 依赖
 
  
配置依赖仓库
 
Gradle 提供配置依赖仓库的功能。mPaaS 常见依赖仓库示例如下：
 

mavenLocal：Maven 本地仓库。您可以 修改本地仓库的路径，更多信息请参见 Local Maven
repository。

<application
android:name="com.alipay.mobile.quinox.LauncherApplication" >
<!-- 启动页的布局配置 -->
<meta-data
android:name="agent.activity.layout"
android:value="layout_splash"/>

</application>

allprojects {
repositories {
mavenLocal()
flatDir {
dirs 'libs'
}
maven {
credentials {
username "*******"
password "*******"
}
url "http://mvn.cloud.alipay.com/nexus/content/repositories/releases/"
}
maven{ url 'http://maven.aliyun.com/nexus/content/groups/public/'}
maven {url 'http://maven.aliyun.com/nexus/content/repositories/google'}
}
}
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flatDir：工程 libs 目录下的依赖。关于 flatDir 类型仓库的更多信息，请参见 Flat directory
repository。
maven：示例中包含 蚂蚁金服金融科技（mvn.cloud.alipay.com） 和 阿里云
（maven.aliyun.com） 的 Maven 仓库。关于 maven 类型仓库的更多信息，请参见 Custom
Maven repositories。
 

您可以在 repositories 下 新增依赖仓库。更多信息，请参见 Repository Types。
  
配置发布仓库
 
Gradle 提供配置发布仓库的功能。本文将简述发布仓库常见示例，帮助您修改本地 Maven 仓库路径（默认
~/.m2）、增加自定义发布仓库。
  
发布仓库示例
 
一般地，build.gradle 文件中有如下配置：
 

这意味着发布仓库为 本地 Maven 仓库，即工程打出的 .jar 包等会自动发布到本地 Maven 仓库。
  
修改本地 Maven 仓库路径
 
本地 Maven 仓库（mavenLocal）默认路径为 ~/.m2，您可以自定义修改。更多信息请参见 Local Maven
repository。
  
自定义发布仓库
 
您可以根据实际情况增加自定义发布仓库，示例如下：
 

uploadArchives {
repositories {
mavenLocal()
}
}

uploadArchives {
mavenDeployer {
mavenLocal()
repository(url: "your_repository_url") {
authentication(userName: '*****', password: '*****')
}
snapshotRepository(url: "your_repository_url") {
authentication(userName: '*****', password: '*****')
}
}
}
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混淆 Android 文件
 
 
mPaaS Android 客户端开发的应用程序是通过 Java 代码编写而成，而 Java 代码易被反编码，因此为了保护
Java 源代码，需要使用 ProGuard 混淆 Android 文件。
 
ProGuard 是一个压缩、优化和混淆 Java 字节码文件的工具。
 

压缩 指检测以及删除没有用到的类、字段、方法以及属性。
优化 指分析以及优化方法的字节码。
混淆 指使用无意义的短变量，对类、变量、方法进行重命名。
 

使用 ProGuard 可以让代码更精简，更高效，也更难被逆向或破解。
  
前置条件
 
您已经配置 mPaaS 工程。
  
关于此任务
 
mPaaS 工程采用组件化方案，每一个 bundle 的编译产物都是一个已经混淆的 dex 文件，所以配置混淆文件
是以 bundle 工程为单位而进行的。
 
portal 工程通常没有代码，不需要开启混淆。
  
代码示例
 

 
Gradle 配置
 

android {
compileSdkVersion 23
buildToolsVersion "19.1.0"

defaultConfig {
applicationId "com.youedata.xionganmaster.launcher"
minSdkVersion 15
targetSdkVersion 23
versionCode 1
versionName "1.0"
}
buildTypes {
release {

移动开发平台mPaaS 接入 Android

70



混淆文件示例
  
下列混淆是一个基本示例（如果要添加额外的第三方库，需要加入其它混淆，通常配置文件可在第三
方库的官网中找到）：
 

// 混淆开关，是否混淆
minifyEnabled true
// 混淆文件列表，混淆规则配置
proguardFiles getDefaultProguardFile('proguard-android.txt'), 'proguard-rules.pro'
}
}
lintOptions {
checkReleaseBuilds false
// Or, if you prefer, you can continue to check for errors in release builds,
// but continue the build even when errors are found:
abortOnError false
}
}

  # Add project specific ProGuard rules here.
# By default, the flags in this file are appended to flags specified
# in ${sdk.dir}/tools/proguard/proguard-android.txt
# You can edit the include path and order by changing the proguardFiles
# directive in build.gradle.

# For more details, see [Shrink your code and
resources](http://developer.android.com/guide/developing/tools/proguard.html)。

# Add any project specific keep options here:

# If your project uses WebView with JS, uncomment the following
# and specify the fully qualified class name to the JavaScript interface
# class:
# -keepclassmembers class fqcn.of.javascript.interface.for.webview {
# public *;
# }
-optimizationpasses 5
-dontusemixedcaseclassnames
-dontskipnonpubliclibraryclasses
-dontpreverify
-verbose
-ignorewarnings
-optimizations !code/simplification/arithmetic,!field/*,!class/merging/*

-keep public class * extends android.app.Activity
-keep public class * extends android.app.Application
-keep public class * extends android.app.Service
-keep public class * extends android.content.BroadcastReceiver
-keep public class * extends android.content.ContentProvider
-keep public class com.android.vending.licensing.ILicensingService
-keep public class com.alipay.mobile.phonecashier.*
-keepnames public class *
-keepattributes SourceFile,LineNumberTable
-keepattributes *Annotation*
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#-keep public class * extends com.alipay.mobile.framework.LauncherApplicationAgent {
# *;
#}

#-keep public class * extends com.alipay.mobile.framework.LauncherActivityAgent {
# *;
#}

-keepclasseswithmembernames class * {
native <methods>;
}

-keepclasseswithmembernames class * {
public <init>(android.content.Context, android.util.AttributeSet);
}

-keepclasseswithmembernames class * {
public <init>(android.content.Context, android.util.AttributeSet, int);
}

-keepclassmembers enum * {
public static **[] values();
public static ** valueOf(java.lang.String);
}

-keep class * extends java.lang.annotation.Annotation { *; }
-keep interface * extends java.lang.annotation.Annotation { *; }

-keep class * implements android.os.Parcelable {
public static final android.os.Parcelable$Creator *;
}

-keep public class * extends android.view.View{
!private <fields>;
!private <methods>;
}

-keep class android.util.**{
public <fields>;
public <methods>;
}

-keep public class com.squareup.javapoet.**{
!private <fields>;
!private <methods>;
}
-keep public class javax.annotation.**{
!private <fields>;
!private <methods>;
}
-keep public class javax.inject.**{
!private <fields>;
!private <methods>;
}
-keep interface **{
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避免混淆通用组件
  
如果在metainfo.xml中注册了通用组件，编译时会检查这些组件是否存在，请避免这些组件被混淆
，否则会编译失败。例如注册了以下组件：
 

 
请在混淆配置中添加：
 

!private <fields>;
!private <methods>;
}
# for dagger
-keep class * extends dagger.internal.Binding
-keep class * extends dagger.internal.ModuleAdapter

-keep class **$$ModuleAdapter
-keep class **$$InjectAdapter
-keep class **$$StaticInjection

-keep class dagger.** { *; }

-keep class javax.inject.**{ *; }
-keep class * extends dagger.internal.Binding
-keep class * extends dagger.internal.ModuleAdapter
-keep class * extends dagger.internal.StaticInjection

# for butterknife
-keep class butterknife.* { *; }
-keep class butterknife.** { *; }
-dontwarn butterknife.internal.**
-keep class **$$ViewBinder { *; }

-keepclasseswithmembernames class * {
@butterknife.* <fields>;
}

-keepclasseswithmembernames class * {
@butterknife.* <methods>;
}

说明：如果在您的 bundle 工程中定义了框架类LauncherApplicationAgent 和
LauncherActivityAgent，请注意进行防混淆设置。

   <metainfo>
<service>
<className>com.mpaas.cq.bundleb.MyServiceImpl</className>
<interfaceName>com.mpaas.cq.bundleb.api.MyService</interfaceName>
<isLazy>true</isLazy>
</service>
</metainfo>

  -keep class com.mpaas.cq.bundleb.MyServiceImpl
-keep class com.mpaas.cq.bundleb.api.MyService
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相关链接
 
ProGuard 帮助手册
 
 

  
mPaaS Portal、Bundle 工程使用 MultiDex 的
注意事项
 
 
不建议您自行在 Portal 和 Bundle 接入方式中接入 MultiDex，除非您是单 portal 工程，需要使用
multiDexEnabled true。如果您的 Bundle 过大，目前只能使用拆分 bundle 的方式进行，不要在 bundle 中
开启 multidex 支持。
 
 
 
数据清理白名单
 
  
背景
 
为应对可能发生的连续启动崩溃的情况，mPaaS 建立了数据清理的机制。该数据清理机制支持定制，通过配置
实现在不同情况下对 SharedPreference 、Database 数据库的清理，在极特殊情况下清空整个应用的数据
，以保证应用的正常运行。目前该机制已经覆盖了 10.1.32、10.1.60 和 10.1.68 系列基线。
 
为满足保护重要数据的需求，mPaaS 在数据清理机制中提供了清理白名单功能。通过将目标文件加入清理白名
单后即可保护该文件不被清理。
 
说明：只有 组件化接入方式（Portal Bundle） 存在数据清理机制。
  
清理白名单方案 1.0
  
简介
 
清理白名单方案 1.0 是在合适的时机调用 MPFramework 中的接口来动态设置白名单列表。
  
支持的基线
 
清理白名单方案 1.0 支持 10.1.32、10.1.60 和 10.1.68 系列基线。
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如果在设置白名单之前已经因为崩溃触发了清理机制，那么清理白名单方案 1.0 将不能生效。如果您使用的是
10.1.32 系列基线，那么建议您升级基线到 10.1.60 或 10.1.68，以使用升级后的清理白名单方案 2.0。更多信
息，请参见 清理白名单方案 2.0。
  
接入步骤
 
只需在合适的时机调用设置清理白名单的接口即可。接口如下：
 

 
清理白名单方案 2.0
  
简介
 
清理白名单方案 2.0 是在触发到清理机制时，框架通过反射加载开发者配置的白名单来设置类，优先读取自定
义的清理策略。
  
支持的基线
清理白名单方案 2.0 支持 10.1.60 和 10.1.68 系列基线。其中：

 /**
* 设置 SharedPreference 白名单。若之前已经设置过，那么会把之前的数据清空。
*/
public static void setSPWhiteList(List<String> whiteList);

/**
* 添加 SharedPreference 白名单，以追加的方式添加。
*
* @param whiteList
*/
public static void addSPWhiteList(List<String> whiteList);

/**
* 获取设置的数据库白名单列表。
*
* @return
*/
public static List<String> getDBWhiteList();

/**
* 设置数据库白名单。若之前已经设置过，那么会把之前的数据清空。
*/
public static void setDBWhiteList(List<String> whiteList) ;

/**
* 添加数据库白名单，以追加的方式添加。
*
* @param whiteList
*/
public static void addDBWhiteList(List<String> whiteList);
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-

1.

10.1.60 基线要求 10.1.60.10 版本及以上。
10.1.68 基线要求 10.1.68.4 版本及以上。
  

接入步骤
 

继承 com.mpaas.framework.adapter.api.ClearDataStrategy，实现相关接口。
 

2.在 Portal 的 AndroidManifest 中配置策略类的信息。
 

 
 

public abstract class ClearDataStrategy {
public ClearDataStrategy() {
}

/**
* 是否开启清理机制。
* 若返回 false，则什么文件都不清理。
* 若返回 true，则会执行清理策略。可以通过 getSPWhiteList，getDBWhiteList 返回需要保证的文件列表。
*
* @return
*/
public abstract boolean enableClearDataStrategy();

/**
* 若开启了清理机制，通过该接口返回需要保护的 SharedPreference 文件。
*
* @return
*/
public List<String> getSPWhiteList() {
return null;
}

/**
* 若开启了清理机制，通过该接口返回需要保护的 db 文件。
*
* @return
*/
public List<String> getDBWhiteList() {
return null;
}
}

说明：由于需要反射调用 ClearDataStrategy，所以不能混淆ClearDataStrategy。

        <meta-data
android:name="ClearDataStrategy"
android:value="com.mpaas.demo.launcher.ClearDataStrategy" />
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隐私权限的清理
 
 
由于 Android 系统的升级变迁和 mPaaS 自身业务的发展等历史原因，在默认的 portal 工程中会存在一部分
冗余权限，如下列表所示。这些权限在当前的 mPaaS 版本中已经不再需要，您可以自行选择删除，或按需保
留。
  
高危可清理权限
 
以下 5 个是高危权限，经过验证可以清除。
 

 
不必要权限
 
以下权限非高危隐私权限，但是是 mPaaS 产品对外不需要使用到的权限。如果有特殊需要的话，可以保留
，否则都可以去除。
 

<uses-permission android:name="android.permission.RECEIVE_SMS" />
<uses-permission android:name="android.permission.READ_SMS" />
<uses-permission android:name="android.permission.READ_LOGS" />
<uses-permission android:name="android.permission.BATTERY_STATS" />
<uses-permission android:name="android.permission.MANAGE_FINGERPRINT" />

<uses-permission android:name="com.alipay.permission.ALIPAY_UPDATE_CREDENTIALS" />
<uses-permission android:name="com.yunos.permission.TYID_SERVICE" />
<uses-permission android:name="com.taobao.permission.USE_CREDENTIALS" />
<uses-permission android:name="com.htc.launcher.permission.READ_SETTINGS" />
<uses-permission android:name="com.majeur.launcher.permission.UPDATE_BADGE" />
<uses-permission android:name="com.aliyun.permission.TYID_SERVICE" />
<uses-permission android:name="com.htc.launcher.permission.UPDATE_SHORTCUT" />
<uses-permission android:name="com.anddoes.launcher.permission.UPDATE_COUNT" />
<uses-permission android:name="com.yunos.permission.STORAGE_SERVICE" />
<uses-permission android:name="com.aliyun.permission.STORAGE_SERVICE" />
<uses-permission android:name="com.alipay.permission.ALIPAY_USE_CREDENTIALS" />
<uses-permission android:name="com.sonyericsson.home.permission.BROADCAST_BADGE" />
<uses-permission android:name="android.permission.SYSTEM_ALERT_WINDOW" />
<uses-permission android:name="nxp.permission.ACCESS_WALLET_SERVICE" />
<uses-permission android:name="com.samsung.android.authservice.permission.READ_CONTENT_PROVIDER" />
<uses-permission android:name="com.alipay.permission.ALIPAY_UPDATE_CREDENTIALS" />
<uses-permission android:name="com.yunos.permission.TYID_MGR_SERVICE" />
<uses-permission android:name="com.aliyun.permission.TYID_MGR_SERVICE" />

<uses-permission android:name="com.android.launcher.permission.UNINSTALL_SHORTCUT" />
<uses-permission android:name="com.android.launcher.permission.INSTALL_SHORTCUT" />

<uses-permission android:name="android.permission.AUTHENTICATE_ACCOUNTS" />
<uses-permission android:name="android.permission.USE_CREDENTIALS" />
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隐私权限弹框的使用说明（Portal&Bundle 接入
方式）
 
  
背景
 
监管部门要求在用户点击隐私协议弹框中“同意”按钮之前，App 不可以调用相关敏感API。为应对此监管要
求，mPaaS Android 10.1.32.17 以上（32 版本） 和 10.1.60.5 以上（60 版本）的基线提供了支持，请您根
据实际情况参考本文对工程进行改造。
  
使用方法
 

 
新建隐私许可弹框回调类。 
在代码中新建一个类，实现PrivacyListener接口，类的实现可以参考以下代码：
 

<uses-permission android:name="android.permission.MANAGE_ACCOUNTS" />
<uses-permission android:name="android.permission.GET_ACCOUNTS" />
<uses-permission android:name="android.permission.WAKE_LOCK" />
<uses-permission android:name="android.permission.WRITE_SETTINGS" />
<uses-permission android:name="android.permission.READ_PROFILE" />
<uses-permission android:name="android.permission.USE_FINGERPRINT" />

public class MyPrivacyListener implements PrivacyListener {
// 在本方法内进行隐私许可弹框
@Override
public void showPrivacy(final Activity activity, final PrivacyResultCallback privacyResultCallback) {
if(null==privacyResultCallback){
return;
}
if(null!=activity){
new AlertDialog.Builder(activity)
.setTitle("隐私许可弹框")
.setMessage("主体内容")
.setPositiveButton("同意继续使用", new DialogInterface.OnClickListener() {
@Override
public void onClick(DialogInterface dialogInterface, int i) {
// 点击确定后，取消弹框
dialogInterface.cancel();
// 将弹框结果设置为 true
privacyResultCallback.onResult(true);
}
})
.setNegativeButton("不同意并退出", new DialogInterface.OnClickListener() {
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@Override
public void onClick(DialogInterface dialogInterface, int i) {
// 点击不同意后，取消弹框
dialogInterface.cancel();
// 将弹框结果设置为 false
privacyResultCallback.onResult(false);
// 结束掉当前的 activity，框架会杀掉进程
if(null!=activity){
activity.finish();
}
}
})
.setCancelable(false)
.create()
.show();
}else{
// 如果 activity 是空的话，回调结果设置 false
privacyResultCallback.onResult(false);
}
}
}

注意：
回调时，一定要弹出一个 dialog 来触发 windowFocusChange，触发后框架才会进行后续的
操作。

-

由于该回调类会由系统框架进行反射初始化，且时机非常早，因此请不要添加带方法名的构造
函数，以及在构造函数中加入具体逻辑。

-

如果您需要在弹出 dialog 这里使用资源，在不同基线下需要采用不同的方法。 在 32 基线下
，您需要采用如下方法：
Resources resource = QuinoxAgent.getInstance().getResourcesByBundle("资源所在的
bundle的bundlename"); 在 60 基线下，您需要在 portal 工程的主 module 下，建立
res_slinks 文件，并将您的资源所在的 bundle 的 group 和 artifact 按照规则写到 res_slinks
文件内。规则为 group-artifact.split("-")[0]。如果组合后内容过长需要换行，请您注意进行
换行处理
例如：
group = com.mpaas.demo.materialdesign
artifact = materialdesign-build，
最终写入 res_slinks 文件中的配置是 com.mpaas.demo.materialdesign-materialdesign。

-
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在 AndroidManifest 中注册弹框回调类。 
在portal的AndroidManifest中注册隐私许可弹框回调类，value是刚才实现的隐私许可弹框回调类
的全路径。代码如下所示。注意将全路径及类名要替换成您自己的回调类。
 

 
在启动时弹框。 
在MockLauncherApplicationAgent的preInit中，加入启动弹框拦截。代码如下所示：
 

 
启动第一个 Activity。 
在MockLauncherActivityAgent的postInit中，进行第一个Activity的跳转。代码如下所示：
 

完成以上内
容后，您可以直接使用 LayoutInflator.inflate(R.layout.xxx) 来调用资源。

<!--隐私许可弹框回调-->
<meta-data
android:name="privacy.listener"
android:value="com.mpaas.demo.launcher.MyPrivacyListener" />

//检测是否要向用户进行隐私许可弹框
if(!PrivacyUtil.isUserAgreed(getApplicationContext())){
PermissionGate.getInstance().waitForUserConform(mContext, getMicroApplicationContext());
}

// 判断是否获取了用户隐私许可
if(PrivacyUtil.isUserAgreed(activity)){
new Handler().postDelayed(new Runnable() {
public void run() {
Intent intent = new Intent(activity, MainActivity.class);
activity.startActivity(intent);
activity.finish();
}
}, 200);
}
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选择基线
 
  
基线简介
 
 
基线是指一系列功能的稳定版本的集合，是进一步开发的基础。而 mPaaS 产品是基于支付宝的某个特定版本
开发的，因此对于 mPaaS 而言，基线则是所基于版本的 SDK 的集合。随着 mPaaS 产品的不断升级，会出现
多个版本的基线。
 
  
10.1.68 基线（beta）
 
mPaaS 10.1.68 基线基于支付宝 10.1.68 版本。
  
新增特性
 

新增了 AAR 接入方式，更贴近原生体验。
为单组件提供了更好的支持，提供单组件 demo，更多信息，请参考 获取代码示例。
优化单组件 SDK 大小，使整体应用包体积有效降低。
对小程序进行更细粒度拆分，用户可根据自身需求进行选择。
更新 UC 内核更新至 3.0，提供了更好的性能和更强的稳定性。
 

详情请参见 发布说明 10.1.68。
  
10.1.60 基线
 
mPaaS 10.1.60 基线基于支付宝 10.1.60 版本。
  
新增特性
 

增加了 小程序组件 正式版。小程序正式版拥有更加完善的 API，且在稳定性、兼容性等方面有了大幅
提高。关于小程序升级请参见 小程序升级说明，关于小程序 IDE 新增调试、预览、发布等功能的详情
请参见 小程序 IDE。
对 H5 容器 整体进行大幅优化，提供了更加简化的接入流程，持续补强能力，在兼容性、稳定性等方
面有显著提高。关于 H5 容器和离线包升级，请参见 H5 容器升级说明。
消息推送组件新增加了对 OPPO 和 vivo 渠道推送的支持。
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新增加了对 社交分享 组件的管理支持，提供了简化的接入流程。
新增加 智能投放 组件。智能投放提供了在应用内个性化投放广告的能力，支持针对定向人群进行个
性化广告投放，帮助 APP 运营人员精准、及时触达用户，详情请参见 智能投放。
 

详情请参见 发布说明 10.1.60。
 
  
10.1.32 基线
 
mPaaS 10.1.32 基线基于支付宝 10.1.32 版本。 
10.1.32 版本是现有 mPaaS 对外发布基线中最早的系列，现已进入维护期，除修复漏洞或 bug 外，不再进行
需求迭代。 
详情请参见 发布说明 10.1.32。
  
选择基线
 

10.1.68 基线正式支持 AAR，如果您需要使用 aar 方式接入，请选择 10.1.68 基线。
目前 10.1.68 基线在 beta 公测阶段，如果您对稳定性的要求比较高，可选择 10.1.60 基线。 
注意：10.1.60 基线暂不支持 AAR 方式接入。
10.1.32 基线已进入维护期，不会有新增功能，因此不推荐新用户使用。
 

  
mPaaS 10.1.68(beta) 升级指南
 
  
关于mPaaS 10.1.68(beta)
 

新增了 AAR 接入方式，更贴近原生体验。更多 AAR 接入方式的信息，请参考 原生 AAR 接入方式。
为单组件提供了更好的支持，提供单组件 demo，更多信息，请参考 获取代码示例。
优化单组件 SDK 大小，使整体应用包体积有效降低。
对小程序进行更细粒度拆分，用户可根据自身需求进行选择。
更新 UC 内核更新至 3.0，提供了更好的性能和更强的稳定性。
  

升级指南
  
AAR 接入指南
 
mPaaS 团队推出了更贴近 Android 原生开发的 AAR 接入方式，帮助您在已有 Android 原生项目的基础上快
速接入 mPaaS 组件。更多信息请参考 AAR 接入指南。
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Inside 接入方式下的升级指南
 
如果您已有基于 Inside 接入方式的工程，请按照以下步骤完成升级。
 

 
环境配置。
 

 
请参考 更新 mPaaS 插件 文档，升级 Android Studio mPaaS 插件到 2.20031016 或以上。
 
在 Android Studio 中的当前工程下，点击菜单 mPaaS > 基线升级，选择 10.1.68(beta)，并点击 
OK
升级成功后，查看 mpaas_packages.json 中，base_line 字段是 10.1.68(beta) 即表示升级成功。
  

组件化接入方式（Portal Bundle）下的升级指南
 
如果您已有基于 Portal&Bundle 接入方式的工程，请按照以下步骤完成升级。
 

请参考 更新 mPaaS 插件 文档，升级 Android Studio mPaaS 插件到 2.20031016 或以上。
在 Android Studio 中的当前工程下，点击菜单 mPaaS > 基线升级，选择 10.1.68(beta)，并点击 
OK
升级成功后，查看 mpaas_packages.json 中，base_line 字段是 10.1.68(beta) 即表示升级成功。
  

组件管理变更
 
在更新至 10.1.68(beta) 之后，以下组件发生了变更，如您之前有选择这些组件，则需要按照以下改动重新操
作。 
更多信息，请参考 组件管理。
 

FRAMEWORK 框架 已变更为可选项。
MAP 地图 已变更为 TINYAPP-MAP 小程序地图。
TINYPROGRAM 小程序 已变更为 TINYAPP 小程序。
MINIPROGRAM-BLUETOOTH 小程序蓝牙 已删除，默认合并至 TINYAPP 、小程序 中。
MINIPROGRAM-MEDIA 小程序多媒体 已变更为TINYAPP-MEDIA 小程序多媒体。
TINYVIDEO 小程序视频 已删除，目前暂时不提供小程序视频。
新增 UCCORE UC内核，之前如果您用到 UC 内核，例如用到了 H5 容器或是小程序，请手动添加该
组件。
  

组件使用升级指南

 gradle = 6.2
com.android.tools.build:gradle:3.5.0
com.alipay.android:android-gradle-plugin:3.5.2
com.android.boost.easyconfig:easyconfig:2.3.7
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H5容器
 
从 10.1.68(beta) 基线开始自定义标题栏的使用方法有了变化，更多信息请参见 自定义导航栏
（10.1.68(beta)）。
  
组件 API 变更
  
H5容器
  
H5TitleView
 
H5TitleView 新增了部分接口，更多信息请参见 自定义导航栏（10.1.68(beta)）。
  
MPNebula
 
新增接口，增加 MicroApplication app 参数。
 

 
扫一扫
 
在 Inside 或 AAR 模式下，如未接入框架，需改用 MPScan 以下方法启动扫一扫标准UI：
 

参数和原 ScanService 一致。
 
 
 
mPaaS 10.1.60 正式版升级指南

 /**
* 启动在线 url
*
* @param app micro app
* @param url 在线地址
*/
public static void startUrl(MicroApplication app, String url)

/**
* 启动在线 url
*
* @param app micro app
* @param url 在线地址
* @param param 启动参数
*/
public static void startUrl(MicroApplication app, String url, Bundle param)

startMPaasScanActivity(Activity activity, ScanRequest scanRequest, ScanCallback scanCallback)；
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关于 mPaaS 10.1.60 正式版
 

10.1.60 基线已适配 Android 10，详情请参考 mPaaS 适配 Android 10 指南。
10.1.60 基线新增加了 小程序组件 正式版。小程序正式版拥有更加完善的 API，且在稳定性、兼容
性等方面有了大幅提高。关于小程序升级请参见 小程序升级说明，关于小程序 IDE 新增调试、预览
、发布等功能的详情请参见 小程序 IDE。
10.1.60 基线对 H5 容器 整体进行大幅优化，提供了更加简化的接入流程，持续补强能力，在兼容性
、稳定性等方面有显著提高。关于 H5 容器和离线包升级，请参见 H5 容器升级说明。
10.1.60 基线中，消息推送新增加了对 OPPO 和 vivo 渠道推送的支持。
10.1.60 基线新增加了对 社交分享 组件的管理支持，提供了简化的接入流程。关于社交分享的升级
，请参见 迁移到 10.1.60 基线。
10.1.60 基线新增加 智能投放 组件。智能投放提供了在应用内个性化投放广告的能力，支持针对定
向人群进行个性化广告投放，帮助 APP 运营人员精准、及时触达用户，详情请参见 智能投放。
10.1.60 基线的整体组件的兼容性、稳定性都有了大幅提高，功能也有着显著提升，具体的发布说明
请参见 Android SDK 发布说明。
  

mPaaS 10.1.60 正式版升级指南
  
操作步骤
 

升级 Android Studio mPaaS 插件到 v2.19123015 或以上。 
关于更新 mPaaS 插件，参见 更新 mPaaS 插件。 
在 Android Studio 中的当前工程下，点击菜单 mPaaS > 基线升级，选择 10.1.60，并点击 OK。 
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升级成功后，查看 mpaas_packages.json 中，”base_line” 字段是 10.1.60 即表示升级成功。 

 

 
组件使用升级指南
 
10.1.60 基线中的 H5 容器、小程序和社交分享组件在接入、使用等方面做了大幅调整。如您接入了上述组件
，需详细阅读下列说明：
 

阅读 H5 容器升级说明 了解 H5 容器和离线包升级的更多信息。
阅读 小程序升级说明 了解小程序升级的更多信息。
社交分享 SDK 接入方式升级: 
阅读 分享 SDK 迁移到 10.1.60 基线 了解 社交分享 组件升级的更多信息。 

说明：10.1.60-beta 基线转为正式版也需要按上述操作。

说明：
从 10.1.60 开始分享 SDK 使用 mPaaS 插件进行管理。如果需要安装分享组件，参见 分享
SDK 迁移到 10.1.60 基线 进行操作。

●

如未使用插件进行分享 SDK 的接入，则会导致分享 SDK 的升级与问题修复不能得到及时更●
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组件 API 变更
 
mPaaS 组件从 10.1.32 基线开始起添加了适配层，如您使用的基线未使用适配层 API，需先行阅读 mPaaS
10.1.32 基线升级指引。
 
建议您在升级 SDK 后使用适配层的 API，具体可参考以下各组件文档中的旧版本升级注意事项：
 

移动分析： 
新增适配器，简化使用，参见 自定义事件日志。
部分 API 废弃，您需使用新的 API，参见 移动分析 SDK 发布说明，否则可能导致编译失败
。

移动推送：新增适配器，简化使用，参见 移动推送 SDK 10.1.32。
移动同步：新增适配器，简化使用，参见 移动同步 SDK 10.1.32。
热修复：新增适配器，简化使用，参见 热修复 SDK 10.1.32。
版本升级：新增适配器，简化使用，参见 版本升级 SDK 10.1.32。
开关配置：新增适配器，简化使用，参见 开关配置 SDK 10.1.32。
H5 容器： 

新增适配器，简化使用，参见 H5 容器 SDK 10.1.32。
容器配置方法变更，如果升级前为 10.0.18 版本，您需使用新的容器配置方法，参见 容器
配置 10.1.32，否则您的容器配置将无法生效。
10.1.60 基线变更参考 升级说明。

小程序： 
先进行 H5 容器升级。
升级变更信息 升级说明。

 

 
定制依赖处理
 
查看所有 build.gradle 中 dependencies 的依赖配置，确认是否配置有 mpaas 组件的bundle 依赖。若有依
赖，且是从低版本 SDK（例如 10.1.32）升级至 10.1.60 版本，您的定制库可能需要基于新版本重新定制，否
则可能会出现不兼容等问题，请 提交工单 或联系 mPaaS 支持人员确认。
 
 
 
解决依赖冲突
 
  
解决依赖冲突

新。

说明：强烈建议您修改代码，使用中间层（适配器）方法而非直接使用底层方法，因为某些底层方法可能会在
将来的版本中发生变更或废弃。如果您继续使用，在将来的更新中可能需要花费更多的时间进行适配。
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由于 mPaaS 的产品依赖部分第三方 SDK，因此在接入 mPaaS 的过程中，可能会遇到项目中已集成的第三方
库与 mPaaS SDK 产生冲突的问题。
 
为应对可能产生的冲突，mPaaS 提供了移除 mPaaS 内部第三方 SDK 的能力，具体移除方法您可以参考：
 

原生 AAR 方式
mPaaS Inside、组件化（Portal&Bundle）方式
 

mPaaS 选择使用的版本具有较高的稳定性和安全性。如果您移除了 mPaaS 所依赖的第三方库，且您使用的
SDK 与 mPaaS 所使用的第三方 SDK 版本不同，请进行足够和充分的测试，以保证功能稳定。
 
如果您遇到了依赖冲突，请参考以下解决方案：
 

解决高德定位冲突
解决高德地图冲突
解决阿里巴巴无线保镖冲突
解决阿里巴巴 utdid 冲突
解决 wire/okio 冲突
解决 fastjson 冲突
解决 android support 冲突
 

  
解决高德定位冲突
 
  
冲突说明
 
mPaaS 内置了高德定位 SDK。如果您的应用因需要在 Google Play 应用市场上线而同时集成高德官方提供的
能通过谷歌审核的版本 SDK 的话，将会遇到高德定位冲突的情况。
  
解决办法
 
移除 mPaaS 内置的高德 SDK（10.1.32 基线不支持）。
  
操作步骤
 

 
确认 mPaaS 所使用的高德定位 SDK 版本，以便您选取相同或相近的过审版本。
 

'com.alipay.android.phone.mobilecommon:AMapSearch:6.1.0_20180330@jar'
'com.alipay.thirdparty.amap:amap-location:4.7.2.20190927@jar'
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获取 mPaaS 使用的高德定位 SDK 的 group:artifact 信息。
 

 
移除 mPaaS 高德定位 SDK。
 

 
AAR 方式
 

 
mPaaS Inside & 组件化（Portal & Bundle）
 

 
  
解决高德地图冲突
 
  
冲突说明
 
mPaaS 内置了高德地图 SDK。如果您的应用因为需要在 Google Play 应用市场上线而同时集成高德官方提供
的能通过谷歌审核的版本 SDK 的话，将会出现高德地图冲突的情况。
  
解决办法
 
移除 mPaaS 内置的高德地图 SDK。
  
操作步骤
 

 
确认 mPaaS 所使用的高德地图 SDK 版本，以便您选取相同或相近的过审版本。
 

'com.mpaas.group.amap:amap-build'

configurations {
all*.exclude group:'com.mpaas.group.amap', module: 'amap-build'
}

mpaascomponents {
excludeDependencies = [
"com.mpaas.group.amap:amap-build"
]
}
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获取 mPaaS 使用的高德地图 SDK 的 group:artifact 信息。
 

 
移除 mPaaS 高德定位 SDK。
 

 
AAR 方式
 

 
mPaaS Inside & 组件化（Portal & Bundle）
 

 
  
解决 utdid 冲突
 
  
解决 utdid 冲突
 
  
冲突说明
 
  
mPaaS 和支付宝支付 SDK 之间的 utdid 冲突
 
由于 mPaaS 和支付宝支付 SDK 均使用了阿里集团的 utdid，如果您在使用了 mPaaS 的同时也使用了支付宝
支付 SDK 的话，会遇到 utdid 冲突。

configurations {
all*.exclude group:'com.alipay.android.phone.thirdparty', module: 'amap3dmap-build'
}

'com.alipay.android.phone.thirdparty:amap3dmap-build'

configurations {
all*.exclude group:'com.alipay.android.phone.thirdparty', module: 'amap3dmap-build'
}

mpaascomponents {
excludeDependencies = [
"com.alipay.android.phone.thirdparty:amap3dmap-build"
]
}
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mPaaS 和其他阿里系 SDK 之间的 utdid 冲突 
 
如果您在使用了 mPaaS 的同时也使用了其他阿里系 SDK，也会遇到 utdid 冲突。
 
  
解决办法
 
如果是 mPaaS 和支付宝支付 SDK 之间的 utdid 冲突，您可以使用 支付宝支付 SDK 提供的去除 utdid 的版本
。详情请参见 支付客户端 DEMO&SDK。
 
如果是 mPaaS 和其他阿里系 SDK 之间的 utdid 冲突，mPaaS 提供了移除 mPaaS utdid 库，使用其他阿里系
SDK 提供的 utdid 的能力。请参照下文操作步骤解决冲突。
  
操作步骤
 

 
确认 mPaaS 所使用的 utdid SDK 的版本，以便您选取相同或相近的版本。
 

 
获取 mPaaS 所使用的 utdid SDK 的 group:artifact 信息。
 

 
移除 mPaaS utdid SDK。
 

 
AAR 方式
 

 
mPaaS Inside & 组件化（Portal & Bundle）
 

 
加入接口包。 

'com.taobao.android:utdid4all:1.5.1.3@jar'

'com.alipay.android.phone.thirdparty:utdid-build'

configurations {
all*.exclude group:'com.alipay.android.phone.thirdparty', module: 'utdid-build'
}

mpaascomponents {
excludeDependencies = [
"com.alipay.android.phone.thirdparty:utdid-build"
]
}
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下载 jar 包 utdid-build-1.1.5.3-api.jar.zip，并引入到工程编译即可。
 
 

  
解决无线保镖冲突
 
  
冲突说明
 
如果在使用 mPaaS 的同时也使用了其他阿里系 SDK，那么可能会出现存在无线保镖冲突
（SecurityGuardSDK）的情况。
  
解决办法
 
mPaaS 提供移除 mPaaS 无线保镖库，使用其他阿里系 SDK 提供的保镖库。
  
操作步骤
 

 
确认当前 mPaaS 所使用的无线保镖 SDK 的版本，以便选取相同或相近的其他阿里系保镖库。
 

 
确认 mPaaS 使用的无线保镖 SDK 的 group:artifact 信息。
 

 
移除 mPaaS 无线保镖。
 

 
AAR 方式
 

 
mPaaS Inside & 组件化（Portal & Bundle）
 

'SecurityGuardSDK-without-resources-5.4.2009'

'com.alipay.android.phone.thirdparty:securityguard-build'

configurations {
all*.exclude group:'com.alipay.android.phone.thirdparty', module: 'securityguard-build'
}

mpaascomponents {
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解决图片冲突。
 

 
config 中增加图片后缀并编译。 
在 config 文件中加入 “authCode”: “1234”，其中，1234可以为任意字符串，建议
使用 4 位数字。
 

 
验证图片后缀是否生效。 
通过反编译，查看生成的 apk 中是否在 drawable 中存在 yw_1222_1234.jpg 图片，以
及在 AndroidManifest 中是否含有如下信息。
 

 
  
解决 wire/okio 冲突
 

excludeDependencies = [
"com.alipay.android.phone.thirdparty:securityguard-build"
]
}

{
"appId":"xxx",
"appKey":"xxx",
"base64Code":"xxx",
"packageName":"xxx",
"rootPath":"xxx",
"workspaceId":"xxx",
"rpcGW":"xxx",
"mpaasapi":"xxx",
"pushPort":"xxx",
"pushGW":"xxx",
"logGW":"xxx",
"syncport":"xxx",
"syncserver":"xxx",
"authCode": "1234"
}

<meta-data
android:name="security_guard_auth_code"
android:value="1234" />

说明： 图片冲突支持以下基线版本：
10.1.32.7 以上i.

10.1.60（beta版需要 beta.7 以上）ii.

10.1.68iii.

移动开发平台mPaaS 接入 Android

93



-

-

  
冲突说明
 
由于 mPaaS 使用 wire/okio 来进行 RPC 网络连接，而 okhttp 也需要引用 okio，所以当您在使用 mPaaS 的
同时使用了 okhttp，那就可能出现 wire/okio 冲突。
 
  
解决方法
 
移除 mPaaS 的 wire/okio 依赖，并对 移动网关 功能进行回归测试以确保功能正常。
  
操作步骤
 

 
确认 mPaaS 所使用的 wire/okio 版本。
 

 
获取 mPaaS 第三方 SDK 的 group:artifact 信息。
 

 
移除 mPaaS 库。
 

AAR 方式 
如果您是采用原生 AAR 方式接入 mPaaS，gradle 的依赖传递会自动使用较高的版本，无
需主动移除。通常来说 mPaaS 选择使用的版本具有较高的稳定性和安全性，建议使用
mPaaS 提供的版本。如果版本不一致，请在上线前对 mPaaS 功能进行测试以保证稳定性
。
mPaaS Inside & 组件化（Portal & Bundle） 

 
加回 wire 或 okio（使用公网的 wire/okio。原生 AAR 方式接入方式无需关注）。 
因为 mPaaS 把 wire 和 okio 的依赖，都写在 com.alipay.android.phone.thirdparty:wire-build

'com.squareup.okio:okio:1.7.0@jar'
'com.squareup.wire:wire-lite-runtime:1.5.3.4@jar'

'com.alipay.android.phone.thirdparty:wire-build'

mpaascomponents {
excludeDependencies = [
"com.alipay.android.phone.thirdparty:wire-build"
]
}
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库内，所以您需要根据实际情况，选择性加回。
 

 
如果只是 okio 冲突，但不存在 wire 冲突，需要加回 wire。
 

 
如果只是 wire 冲突，但不存在 okio 冲突，需要加回 okio。
 

 
  
解决 fastjson 冲突
 
  
冲突说明
 
mPaaS 使用 fastjson 来进行 json 解析，如果您在项目中也使用了 fastjson 的话，则会出现 fastjson 冲突。
  
解决办法
 
移除 mPaaS 中的 fastjson-build。
  
操作步骤
 

 
确认当前 mPaaS 所使用的 fastjson 版本。
 

 
获取 mPaaS 使用的第三方 SDK 的 group:artifact 信息。
 

 
移除 mPaaS 库。
 

 

implementation 'com.squareup.wire:wire-lite-runtime:1.5.3.4@jar'

implementation 'com.squareup.wire:wire-lite-runtime:1.5.3.4@jar'

'com.alibaba:fastjson:1.1.70.android@jar'

'com.alipay.android.phone.thirdparty:fastjson-build'
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AAR 方式 
如果您是原生 AAR 方式接入 mPaaS，则无需主动移除，gradle 依赖传递会自动使用较高
的版本。mPaaS 选择使用的版本具有较高的稳定性和安全性，建议使用 mPaaS 提供的版
本。如果版本不一致，请在上线前对 mPaaS 功能进行测试以保证稳定性。
 
 
mPaaS Inside & 组件化（Portal & Bundle）
 

 
  
解决 android support 冲突
 
  
冲突说明
 
mPaaS 内置了基于 23.2.1 版本的 support 库，同时添加了 Fragment 切面逻辑进行自动化页面埋点。如果在
使用 mPaaS 的同时也添加了官方版本的 android support 库的话，会出现 android support 冲突。
  
解决方法
 
移除 androidsupport-build，直接替换为官方版本。如果还需要使用 mPaaS 提供的的 Fragment 自动化日志
功能，您需要手动添加 监控逻辑。
 
注意：原生 AAR 方式并没有内置 support 库，因此您无需做任何处理。但如果您需要使用 mPaaS 提供的
Fragment 自动化日志功能，请手动添加 监控逻辑。
 
  
 
  
操作步骤
 

 
确认当前 mPaaS 所使用的 android support 版本。
 

mpaascomponents {
excludeDependencies = [
"com.alipay.android.phone.thirdparty:fastjson-build"
]
}

'com.android.support:support-v4'
'com.android.support:appcompat-v7'
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获取mPaaS 第三方 sdk 的 group:artifact 信息。
 

 
移除 mPaaS 库。
 

 
AAR 方式 
如果您是原生 AAR 方式接入 mPaaS，无需主动移除。
 
 
mPaaS Inside & 组件化（Portal & Bundle）
 

 
  
开发者工具
 
  
Android Studio mPaaS 插件
 
  
关于 mPaaS 插件
 
 
mPaaS 插件是一个具有图形化界面的插件工具，该工具提供了编译打包、管理组件依赖、热修复、加密图片等
功能，用于帮助开发者能够快速接入 mPaaS 并辅助进行开发工作。安装 mPaaS 成功后我们会在 Android
Studio 的顶部菜单栏看到 mPaaS 。
 

 
点击 mPaaS ： 

'com.alipay.android.phone.thirdparty:androidsupport-build'
'com.alipay.android.phone.thirdparty:androidsupportrecyclerview-build'

mpaascomponents {
excludeDependencies = [
"com.alipay.android.phone.thirdparty:androidsupport-build"
]
}
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如图，mPaaS 插件提供多种开发辅助功能，包括：
 

功能
mPaaS 插件

组件化 Inside

编译打包 编译打包 Build、Build Setting

管理组件依赖 管理组件依赖 基线升级、组件升级、组件管理

迁移原生工程至 mPaaS 框架 迁移原生工程至 mPaaS Inside 安装 mPaaS Portal、安装
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相关链接
 

配置开发环境：了解配置开发环境的方法，其中包含了 mPaaS 插件的安装方法。
安装 mPaaS 插件：在Android Studio 中如何安装 mPaaS 插件。
使用 mPaaS 插件：mPaaS 插件的各个功能的使用简介。
更新及卸载 mPaaS 插件：对 mPaaS 插件进行更新或卸载。
 

  
安装 mPaaS 插件
 
 
mPaaS 插件提供多种开发辅助功能，包括：新建 mPaaS 工程，添加、删除和升级 mPaaS 组件，构建工程等
。为方便您使用以上功能，本文将向您介绍 mPaaS 插件的安装过程。
 
根据安装形式的不同，mPaaS 插件的安装分为 在线安装 和 离线安装 两种形式。
 

如果您的 Android Studio 为 3.6 及以上版本，请选择 在线安装 形式。
如果您的 Android Studio 为 3.5 版本，请选择 离线安装 形式。
  

在线安装
  
操作步骤
 

在 Android Studio 中，通过 File > Settings 打开设置对话框。
点击左侧 Plugins，然后点击右上方的 

mPaaS Inside

热修复包 生成热修复补丁、合并补丁

加密图片

生成加密图片（专有云）
生成加密图片（专有云配置）
Generate YWJpg RSA
生成加密图片（通过配置文件）
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3.

，并在下拉菜单中
选择 Manage Plugin Repositories。 

在弹出的 Custom Plugin Repositories 窗口中，点击 + 按钮，在新增的行中输入
https://mulei.oss-cn-hangzhou.aliyuncs.com/updatePlugins.xml，然后点击 OK。 

说明：对于个别版本的 Android studio，可能需要在输入仓库地址后，鼠标单击下方空白区域（或
按 Enter 键）后，再点击 OK 进行添加，否则可能出现添加失败，无法连接的情况。
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4.

5.

1.

2.

返回 Plugins 窗口后，在 Marketplace 选项卡下搜索 mpaas。在搜索结果中，点击搜索到的
mPaaS 插件下方的 Install 安装该插件。 

等待插件安装结束，重启 Android Studio 后，您将在顶部的菜单中看到 mPaaS 插件： 

  
离线安装
  
前提条件
 
您已经获得了 mPaaS 插件的安装包。
 
mPaaS 插件离线安装包（适用于 Android Studio 3.5） 下载链接 。
  
操作步骤
 

在 Android Studio 中，通过 Android Studio > Preference 打开设置对话框。
点击左侧 Plugins，然后点击右上方的 
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3.

，并在下拉菜单中
选择 Install Plugin from Disk。 

选择您已经下载到的 mPaaS 插件安装包，点击 确认 即可安装。安装完成后，根据提示重启
Android Studio，您就可以开始使用 mPaaS 插件了。 

说明： mPaaS 插件的安装包为压缩包文件形式，在安装前无需解压。
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1.

2.

 
  
使用 mPaaS 插件
 
 
mPaaS 插件提供图形化界面，帮您快速接入 mPaaS。功能包括：原生 AAR 接入、mPaaS Inside 接入、组件
化方式 Portal&Bundle 接入、基础工具、帮助、构建。 
点击 mPaaS，进入 mPaaS 插件主界面，如下图所示。本文将对 mPaaS 的功能进行逐一说明。
 

  
原生 AAR 接入
 

点击 mPaaS > 原生 AAR 接入 > mPaaS 接入。 

可选择 mPaaS 和相关组件添加到项目中。 
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3. 添加 mPaaS 到项目中，点击 mPaaS 。 
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4.

5.

点击 点击添加。 

选择 mPaaS 基线版本，点击 OK。 
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1.

 
mPaaS 接入成功。 

  

 
  

mPaaS Inside 接入
 

点击 mPaaS > mPaaS Inside 接入 > 安装 mPaaS Inside。 
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2.

3.

到 mPaaS 官网注册账号，并创建应用。创建完成后下载配置文件。然后点击 Next。 

在 mPaaS Config Location 后选择下载的配置文件，其他内容会自动填充。 
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4.

1.

2.

点击 Finish，会显示项目迁移成功的提示。 

  
组件化方式 Portal&Bundle 接入
 

点击 mPaaS > 组件化方式 Portal&Bundle 接入 > 安装 mPaaS Portal。 

选择 原始工程路径 和 配置文件地址，点击 OK。 
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2.

 
组件管理
 

点击 mPaaS > 原生 AAR 接入 或 mPaaS Inside 接入 或 组件化方式 PortalBundle 接入 > 组件管
理。 

可升级当前基线版本，点击按钮安装需要的组件和能力。 
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3.

1.

2.

升级和安装完成后关闭即可。
  

基线升级
 

点击 mPaaS > 原生 AAR 接入 或 mPaaS Inside 接入 或 组件化方式 PortalBundle 接入 > 基线升
级。 

选择需要升级的基线版本。 
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3.

4.

确认升级的基线版本号。 

升级成功后会弹出项目迁移成功的弹窗。 

  
自定义基线
 
通常情况下，我们提供的基线是面向所有客户的，如 10.1.20、10.1.32、10.1.60 。如果您需要定制一些
mPaaS 的功能，您需要向和您对接的人员提出需求，我们会按照您的需求为您定制基线。在交付的时候
，mPaaS 的工作人员会向您提供定制基线的 ID，您只需要在 mPaaS 插件中填写该 ID， 即可获得此定制基线
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。
  
前提条件
 
确认您的 Android Studio mPaaS 版本为 V2.19111217 或以上。您可以参考 更新 mPaaS 插件 以了解当前的
mPaaS 插件版本和如何升级 mPaaS 插件。
  
操作步骤
 

 
删除您 Android Studio 工程里已经存在的 mpaas_package.json 文件。
 
 
点击 Android Studio 的菜单 mPaaS > mPaaS Inside 接入 > 基线升级。
 
 
在 基线升级 对话框中勾选 自定义基线 并输入您得到的定制基线 ID。 

 
点击 OK，即完成自定义基线的引入。
  

基础工具
 
基础工具中包含 热修复 和 生成加密图片 的功能。
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热修复
 
使用热修复能力前，首先要让 App 具备热修复的能力。具体内容，查看 热修复管理：接入 Android——基于
mPaaS 框架。
  
生成热修复补丁
 
使用 mPaaS 插件的 生成热修复补丁，通过以下步骤生成热修复包：
 

 
针对不同的 mPaaS 集成方式，选择对应的包，通过 mPaaS 插件的 生成热修复补丁 生成热修复包
。 

 
原生工程 和 mPaaS Inside 工程：准备以下不同类型的 .apk 包，根据代码的不同，生成热
修复包。 

有 bug 的线上 .apk 包。
修复后的 .apk 包。 

 
提示：在 New bundle 栏，填写修复后的 apk 包的本地地址。在 Old
bundle 栏， 填写有 bug 的 apk 包的本地地址。在 白名单 一栏输入白名
单。
 
 

 
mPaaS 框架：准备以下类型的 bundle 包。
 

正在使用的有 bug 的 bundle 包。
修复后的 bundle 包。 

 
提示：bundle 的输出路径为 bundle 的主 module 目录下的
build/intermediates/bundle/xxxx-raw.jar。如果是 release 包则没有 -
raw。其中：
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New bundle：选择修复 bug 的包路径。
Old bundle：选择有 bug 的包路径。
白名单：指定修复的类，使用原生工程和 mPaaS Inside 时强烈
推荐这个功能，后文介绍白名单功能。
Patch file dir：输出的 patch 包路径。 
是否使用 dexPatch：选择是否使用 dexPatch 热修复方式。
mPaaS 插件的 生成热修复补丁 功能支持 Andfix 和 dexPatch 两
种热修复方式。不论使用哪种热修复方案，在发版本前都需要进
行验证，查看热修复包是否能生效： 

如果不勾选该复选框，那么会生成 Andfix 热修复包
，其优点在于补丁立即生效，不需要重启应用即刻生效
，缺点在于有机型问题，修复的场景限制较多。
如果勾选该复选框，那么会生成 dexPatch 热修复包
，dexPatch 不能立即生效，需要杀掉进程后才能生效
，但优点在于修复的场景比 Andfix 多，且机型适配问
题少。 

 
 

 
 
输入签名信息生成热修复包。
 

 
注意：生成热修复包所需要的签名文件必须和运行的 .apk 的签名文件保持一致，并且签名文件
和生成图片选择的 .apk 的签名文件也要保持一致。生成的图片需要放在 Portal 工程的
res/drawable 文件夹下面，命名为 yw_1222.jpg。
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合并补丁
 
一个 Android App 版本最多只能有一个热修复包在运行。如果客户端某版本有两个 bug，那需要先在本地使
用 合并补丁 功能将修正两个 bug 的热修复包合成一个热修复包。
 

多 Bundle 补丁时，需要合并热修复包。一个 Android App 版本最多只能有一个热修复包在运行。如果客户端
某版本有两个 bug，需要先在本地使用 合并补丁 功能将修正两个 bug 的热修复包合并为一个热修复包。例如
，针对某一个版本的 App 已经发过热修复包 A， 之后在这个版本上又发现了另外一个问题，这时可在本地生
成另外一个热修复包 B，然后合并 A 与 B 两个热修复包，最后下发到客户端。
 
使用 mPaaS 插件的 合并补丁，通过以下步骤合并热修复包：
 

 
填写热修复包文件夹地址：
 

Merge dir：选择合并的 hotpatch 包目录。文件夹下面是所有的需要合并的包，包名需要
以 .jar 或者 .apk 结尾。 
Patch file dir：选择合并之后输出的热修复包目录。 

说明：本节仅针对使用 Bundle 工程的用户，mPaaS Inside 和原生工程用户可以在原先修复的基础上，相对于
最原始未修复的包再打出一个补丁发布即可。

移动开发平台mPaaS 接入 Android

115



 
配置签名信息： 

 
 
收到合并成功的提醒： 

 
 
最终合并的热修复包，如下图所示： 

移动开发平台mPaaS 接入 Android

116



1.

 
  

生成加密图片
 
为了安全，mPaaS 某些组件（如热修复）访问网络时需要对内容进行加密。具有特殊名称 yw_1222.jpg 的图
片为加解密提供密钥信息。mPaaS 组件自动使用该图片进行加解密，无需额外操作。
 
生成并使用加密图片 yw_1222.jpg 的详情如下。
  
准备
 
加密图片与 APK 的签名文件有绑定关系。因此，需要准备 Portal 工程签名之后的 APK。具体的签名步骤，请
参考 Android 官网。
 

 
生成
 
您可以通过 mPaaS 插件 生成加密图片。
 

在 Android Studio 中，点击 mPaaS > Generate YWjpg(Private)。您将看到如下对话框： 

说明：
此处的 APK 应和 发布版本 的 APK 使用相同的签名文件。-

给应用签名时，Signature Versions 中 V1(Jar Signature) 必须勾选，V2(Full APK Signature) 可按
需勾选：

-

生成的加密图片只能用在该 APK 工程中。-
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3.

4.

5.

6.

7.

1.

2.

i.

ii.

点击 Release Apk 最右侧的 ...， 选择 Portal 工程签名之后的 apk 文件， RSA 会自动填充。
点击 manifestFile 最右侧的 ...， 选择 Portal 工程的 AndroidManifest.xml 文件， workSpaceId、
appId 和 packageName 会自动填充。如果没有，可以根据工程的 .config 文件中的配置填写到对
应输入框中。
填写 appsecret 。 

 
注意：作为服务端管理人员，您可以从控制台中查询 appid 所对应的 appsecret。
 
 

在 jpg Version 栏，填写对应的无线保镖图片版本号。 
 
查看 Portal 工程主 module 下 build.gradle 文件中 securityguard 版本，低于 5.4 的填 4
（例如基线中给出的 securityguard-build:5.1.38.180402194514），其余填 5 。
 
 

点击 outPath 最右侧的 ...， 选择无线保镖图片 yw_1222.jpg 的输出路径，即加密图片生成的本地
路径。
点击 OK 生成加密图片。
  

使用
 
加密图片的使用步骤如下：
 

将加密图片 yw_1222.jpg 存放到 Portal 工程的 res/drawable 文件夹中。
如使用 ProGuard，需避免加密图片被混淆。 

检查 build.gradle 中是否配置了如下内容： 

若有如上配置，为了避免加密图片被混淆，需要在 res/raw 下创建 keep.xml 文件。文件
内容如下： 

minifyEnabled true
shrinkResources true
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2.

3.

帮助
  
日志诊断工具
 

点击 mPaaS > 帮助 > 日志诊断工具。 

将您需要分析的日志信息 copy 到输入框，点击 Next。 

等待分析结果。 

<?xml version="1.0" encoding="utf-8"?>
<resources xmlns:tools="http://schemas.android.com/tools"
tools:keep="@drawable/yw_1222*" /><!--tools:discard="@layout/unused2"-->
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查看分析结果。 
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5.

  
分析结果中主要包含定位原因和解决方案，您可以根据具体的定位信息和解决方案来修改您的代码。
 
修改完成后点击 Finish 关闭弹窗。
  

常见问题
 
点击 mPaaS > 帮助 > 常见问题，即可跳转至 接入 Android 常见问题，查看接入过程中的常见问题。
 

  
查看文档
 
点击 mPaaS > 帮助 > 查看文档，即可跳转至 mPaaS 文档中心，查看各组件的使用文档。
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2.

  
构建
 

在 Android Studio 中选择 mPaaS > 构建。 

Build 执行 gradle 命令，用于编译打包。 

 
  
更新及卸载 mPaaS 插件
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1.

 
本文向您介绍如何更新及卸载 mPaaS 插件。
 

 
更新 mPaaS 插件
 

打开 Android Studio，点击 File > Settings。
 
在打开的 Settings 窗口的左侧导航栏，选择 Plugins。
  

 
 
在窗口右侧，选择 Updates 选项卡，搜索并找到 mPaaS 插件，点击其右侧的 Update。
  

说明：本文档中的截图是从 Windows 环境下获得，MacOS 和 Linux 环境下操作流程与 Windows 环境下相
似，此处不再赘述。
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在弹出的第三方插件隐私说明中，点击 Accept。
  

 
 
随后，Android Studio 会自动下载 mPaaS 插件。
  

 
 
更新完毕后，点击 Restart IDE。并在弹出的确认窗口中点击 Restart 重启 Android Studio。
  

 
 
重启 Android Studio 后，重新进入 File > Settings > Plugins，您即可看到 mPaaS 插件已更新至
最新版本。
  

 
  

卸载 mPaaS 插件
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1. 打开 Android Studio，点击 File > Settings。
 
在打开的 Settings 窗口的左侧导航栏，选择 Plugins。
  

 
 
在窗口右侧的 Installed 选项卡中，搜索并找到 mPaaS 插件，点击插件名，进入插件详情页。
  

 
 
在 mPaaS 插件详情页，点击窗口右上方 Disable 右侧的下拉箭头，选择 Uninstall。
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在弹出的确认窗口中，点击 Yes 即可卸载 mPaaS 插件。
  

 
 

  
开发小助手
 
  
关于开发小助手
 
 
开发小助手 DevHelper 是基于 mPaaS 框架，整合了解决用户常见问题的开发工具集，该工具集随着 mPaaS
插件一起提供给开发者（点击快速了解开发小助手的功能）。在将开发工程接入 mPaaS 后或基于 mPaaS 插件
创建工程后，即可将开发小助手接入开发工程（点击快速了解如何使用开发小助手），使用开发小助手进行调
试、帮助开发。 
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在应用中，开发小助手以悬浮窗的形式出现，在应用中的任何界面都可以点击悬浮窗，唤出开发小助手主页。 
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开发小助手的功能
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开发小助手提供的功能可分为四大类：LOG 日志类、TOOL 工具类、UI 界面类和OTHER 其他类。 

  
LOG 日志类
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日志类包含闪退、沙盒浏览和日志三个功能。 

  
闪退
 
闪退功能支持快速查看闪退日志。 
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沙盒浏览
 
沙盒浏览功能支持查看 App 的所有文件。 
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日志
 
日志功能支持查看输出的客户端 Logcat日志。 
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TOOL 工具类
 
TOOL 工具类提供的功能有 Web 任意门、App 基础信息、清理数据、微应用启动时长、Bundle 版本信息、
Activity 辅助信息、广告、和 CPU 运行信息。在 TOOL 工具类，您还可以通过 设置 对开发小助手的部分功能
进行配置。 
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Web任意门
 
Web任意门功能支持通过开发小助手打开离线包或者在线页面。在输入网址、或者扫描二维码后，即可打开离
线包或者在线网页。 
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App 基础信息
 
显示App的基本信息。 
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清理数据
 
清理App的所有缓存以及数据信息。在清除数据后，App会自动退出。 

  
微应用启动时长
输入微应用的AppId，就可以查看和统计微应用的启动耗时。 
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bundle 版本信息
 
显示mPaaS框架下Bundle的版本号。 
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activity 辅助信息
 
提供微应用启动Activity的参数信息。 
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广告
 
智能投放广告的动态化工具。在接入智能投放并预置展位后，可以动态给某一个位置查一个广告，并且可以提
取页面上的广告。 
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CPU 运行信息
 
打开 CPU检测开关 后，即可显示 CPU 使用率信息。该信息以浮层的形式在屏幕上方显示，此时您可以切换到
应用的其他页面使用应用的不同功能，对 CPU 的使用率信息进行实时监控。 
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通过 检测记录 菜单，您还可以查看 CPU 运行信息的检测记录。 
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设置
 
在 设置 中，您可以查看对开发小助手的功能进行配置。这些功能包括无障碍支持性扫描、热区自动扫描、超长
文案自动扫描、卡顿实时监控、日志和浮动通知。 
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无障碍支持性扫描 
支持对 android 视障人群功能的界面检查。
热区自动扫描 
热区检测可以检测页面中点击区域的宽或高小于 30dp 的控件，并将检测结果实时显示在当前页面顶
部。如果开启此开关，则会对扫描到的热区中宽或高小于 30dp 的控件自动标红。
超长文案自动扫描 
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可以实现对重叠文本的检查。因为文本超长之后文字会不显示，通过开发小助手，就可以通过文本控
件的 api 检查出来。
卡顿实时监控 
开启后，开发小助手会实时监控 App 的运行状态，一旦发生卡顿，就会以悬浮窗的形式进行提醒。
点击悬浮球，即可查看卡顿信息。 
查看卡顿信息后返回 App，悬浮窗会自动消失。 
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日志 
开启此开关后，即可阅读日志类型的文件。
浮动通知 
关闭此开关时，发生卡顿时将不会再弹出悬浮窗通知。
  

UI 界面类
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UI 界面类提供的功能有 热区检测、XPath 信息 和 界面标注。 

  
热区检测
 
热区检测可以检测页面中点击区域的宽或高小于 30dp 的控件，并将检测结果实时显示在当前页面顶部。 
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XPath 信息
 
热区检测可以检测页面中显示控件的 XPath 信息。打开 事件拦截 开关后，开发小助手会将 XPath 信息记性显
示。 
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界面标注
 
界面标注可以将页面中的控件大小标注出来，标注分为自动和手动两种方式。
 

自动标注：开发小助手会自动将当前页面中的所有控件进行标注。 
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- 手动标注：开发小助手会只标注被点击了的控件。 
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OTHER 其他类
 
OTHER 其他类提供了跳转到开发小助手帮助文档的入口。同时，对开发小助手拓展的功能也会显示在 OTHER
其他类。 
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关于开发小助手
 
跳转到开发小助手的帮助文档。
  
拓展的功能
 
用户自己拓展的功能都会显示在 OTHER 其他类 中。如下图所示，“拓展接入”即为一个拓展的开发小助手的
功能。 

 
 
 
使用开发小助手
 
 
本文将从接入、启动和拓展三方面向您介绍如何使用开发小助手。
  
接入开发小助手
  
前置条件
 
已接入mPaaS 框架。
  
接入步骤
 
您只需在 Portal 工程的 build.gradle 文件中加入如下代码，即可完成开发小助手的接入。
 

devbundle "com.mpaas.android.dev.helper:devhelper-build:1.0.0.200514150006@jar"
devmanifest "com.mpaas.android.dev.helper:devhelper-build:1.0.0.200514150006:AndroidManifest@xml"
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2.

1.

启动开发小助手
 
开发小助手随 mPaaS 框架启动，无需额外代码启动。但在以下情况下，在启动开发小助手时需要特别注意：
 

当安卓手机运行在monkey模式下时，开发小助手自动不启动。
当开发模式为 release mode 时，即 android:debuggable="false" 时，开发小助手默认不启动。
如果需要在 release mode 下启动开发小助手，可以通过在 AndroidManifest.xml 文件中设置如下
属性强制启动开发小助手。但是在正式发布时一定要去掉该功能。代码配置如下： 

并且将开发小助手的依赖按照如下代码所示进行更换： 

  
拓展开发小助手
 
在实际使用中，您还可以根据实际需求，对开发小助手进行功能拓展，如查看用户的加密数据。拓展的功能依
赖于增加新的实现类。
  
拓展步骤
 

在 assets 文件夹中添加加一个 .devhelper.json 结尾的文件，并确保文件名唯一。该json文件需包
含以下代码： 

className：类名。该类名即步骤2中新建的实现类的类名。bundleName：bundle 名。bundle
名可在主 module 的 /build/intermediates/bundle/META-INF/BUNDLE.MF 文件中查看。如果该
拓展功能是加在 Portal 工程中，则 bundleName 需填空字符串 “”。
 
新建一个类并实现如下方法，需要确保该类有且只有一个无参构造方法。
 

<meta-data
android:name="devhelper_start"
android:value="true" />

bundle "com.mpaas.android.dev.helper:devhelper-build:1.0.0.200514150006@jar"
mainfest "com.mpaas.android.dev.helper:devhelper-build:1.0.0.200514150006:AndroidManifest@xml"

[
{
"className": "com.alipay.android.phone.devtool.devhelper.woodpecker.panel.items.SpmItem",
"bundleName": "com-mpaas-android-dev-helper-devhelper"
}
]

/**
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代码示例
 
以下为一个拓展开发小助手的简单示例。该示例增加了拓展功能 拓展接入，实现点击图标后返回字符串
“onclick”的功能。
 

* @param context
* @return 小助手面板入口图片
*/
Drawable icon(Context context);

/**
* @param context
* @return 小助手面板显示的名称
*/
String title(Context context);

/**
* @param context
* @return 是否处理相应，如已处理，请返回True
*/
boolean onClick(Context context);

/**
* @param context
* @return 该功能是否可用，如可用，请返回True
*/
boolean enabled(Context context);

/**
* 返回如下分组
* {@link #GROUP_OTHER} = 'OTHER'
* {@link #GROUP_TOOL} = 'TOOL'
* {@link #GROUP_UI} = 'UI'
* {@link #GROUP_LOG} = 'LOG'
*
* @return
*/
String group();

package com.alipay.mpaas.test.helper;

import android.annotation.TargetApi;
import android.content.Context;
import android.graphics.drawable.Drawable;
import android.os.Build;
import android.widget.Toast;
import com.mpaas.demo.R;

public class SpmItem {
private final static String TAG = SpmItem.class.getName();

@TargetApi(Build.VERSION_CODES.LOLLIPOP)
public Drawable icon(Context context) {
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运行结果
 
如下图所示，在开发小助手的 OTHER 其他类 中已经增加了 拓展接入，点击图标后，即可显示字符串

return context.getDrawable(R.drawable.appicon);
}

public String title(Context context) {
return "拓展接入";
}

public boolean onClick(Context context) {
Toast.makeText(context,"onclick",Toast.LENGTH_LONG).show();
return true;
}

public boolean enabled(Context context) {
return true;
}

public String group() {
return "OTHER";
}
}
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“onclick”。 )
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参考
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2.
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1.

2.

1.

2.

  
mPaaS Inside/组件化接入方式下的环境配置
 
 
在进行客户端开发之前，您首先需要配置开发环境：
 

配置 Windows 开发环境
配置 macOS 开发环境
配置 Linux 开发环境
  

配置 Windows 开发环境
 
参考以下说明配置 Windows 开发环境：
  
配置 Java 8 环境
 
mPaaS 框架只支持 JDK 8+：
 

下载并安装 JDK 8。
配置 JAVA_HOME 环境变量，并将 JAVA_HOME 下的 bin 路径添加到 PATH 环境变量中。
正确配置后，在命令行执行 java -version 命令，您将看到 JDK 版本等信息： 

  
配置 Gradle 4.4 环境
 
mPaaS 框架只支持 Gradle 4.4。
  
使用 Gradle Wrapper（推荐）
 

如果您的项目原先已经使用 Gradle Wrapper 进行构建，则建议在项目目录
/gradle/wrapper/gradle.properties 下把版本号修改为4.4。
如果您的项目没有使用 Gradle Wrapper，建议先使用全局的 Gradle（4.4）版本，然后调用
gradle wrapper --gradle-version=4.4 安装一个 gradle wrapper。完成上述步骤后，您只需要使
用 ./gradlew 的形式构建，这样的方式能最小的影响您的开发环境。
  

使用独立 gradle
 

下载 Gradle 4.4.zip。
解压 .zip 包，然后将解压路径配置为 GRADLE_HOME 环境变量，并将 GRADLE_HOME 下的 bin
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3.

-

-

-

1.

2.

路径添加到 PATH 环境变量中。
正确配置后，在命令行执行 gradle -v 命令，您将看到 Gradle 版本等信息： 

  
安装并配置 Android Studio
  
安装 Android Studio
 
mPaaS 框架支持 3.6 及以上版本的 Android Studio。
 

关于 Android Studio 下载，请参见 Android Developers。
安装指南。
如果您之前使用的是低版本 Android Studio 并已经安装了 mPaaS 插件，那么在您从低版本
Android Studio 升级至 3.6 版本的 Android Studio 之后，您只需要升级 mPaaS 插件至最新版本即
可。详情请参见 更新 mPaaS 插件。
  

安装 Android SDK
 
您需要安装 API Level 为 19 和 26 的 Android SDK：
 

在 Android Studio 中，通过 File > Settings 打开设置对话框。
如下图所示，在 Android SDK 对话框中，勾选 API Level 为 19 和 26 的 SDK，然后点击 Apply 按
钮进行安装： 
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1.

2.

 
安装 mPaaS 插件
 
mPaaS 插件提供多种开发辅助功能，包括：新建 mPaaS 工程，添加、删除和升级 mPaaS 组件，构建工程等
。安装步骤如下：
 

在 Android Studio 中，通过 File > Settings 打开设置对话框。
点击左侧 Plugins，然后点击右上方的 
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3.

，并在下拉菜单中
选择 Manage Plugin Repositories。 

在弹出的 Custom Plugin Repositories 窗口中，点击 + 按钮，在新增的行中输入
https://mulei.oss-cn-hangzhou.aliyuncs.com/updatePlugins.xml，然后点击 OK。 

说明：对于个别版本的 Android studio，可能需要在输入仓库地址后，鼠标单击下方空白区域（或
按 Enter 键）后，再点击 OK 进行添加，否则可能出现添加失败，无法连接的情况。
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4.

5.

1.

2.

返回 Plugins 窗口后，在 Marketplace 选项卡下搜索 mpaas。在搜索结果中，点击搜索到的
mPaaS 插件下方的 Install 安装该插件。 

等待插件安装结束，重启 Android Studio 后，您将在顶部的菜单中看到 mPaaS 插件： 

  
配置 Gradle 构建工具
 
您需要确保工程构建时使用 Gradle Wrapper：
 

在 Android Studio 中，通过 File > Settings 打开设置对话框。
如下图所示，在 Gradle 对话框中，勾选 Use default gradle wrapper，然后点击 Apply 按钮： 
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1.

2.

3.

1.

2.

1.

2.

3.

配置 macOS 开发环境
 
按照以下描述配置 macOS 开发环境：
  
配置 Java 8 环境
 
mPaaS 框架只支持 JDK 8+：
 

下载并安装 JDK 8。
配置 JAVA_HOME 环境变量，并将 JAVA_HOME 下的 bin 路径添加到 PATH 环境变量中。
正确配置后，在命令行执行 java -version 命令，您将看到 JDK 版本等信息： 

  
配置 Gradle 4.4 环境
 
mPaaS 框架只支持 Gradle 4.4。
  
使用 Gradle Wrapper（推荐）
 

如果您的项目原先已经使用 Gradle Wrapper 进行构建，则建议在项目目录
/gradle/wrapper/gradle.properties 下把版本号修改为4.4。
如果您的项目没有使用 Gradle Wrapper，建议先使用全局的 Gradle（4.4）版本，然后调用
gradle wrapper --gradle-version=4.4 安装一个 gradle wrapper。完成上述步骤后，您只需要使
用 ./gradlew 的形式构建，这样的方式能最小的影响您的开发环境。
  

使用独立 gradle
 

下载 Gradle 4.4.zip。
解压 .zip 包，然后将解压路径配置为 GRADLE_HOME 环境变量，并将 GRADLE_HOME 下的 bin
路径添加到 PATH 环境变量中。
正确配置后，在命令行执行 gradle -v 命令，您将看到 Gradle 版本等信息： 

  
安装并配置 Android Studio
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1.

2.

1.

2.

安装 Android Studio
 
mPaaS 框架支持 3.6 及以上版本的 Android Studio。
 

关于 Android Studio 下载，请参见 Android Developers。
关于 Android Studio 安装，请参见 安装指南。
如果您之前使用的是低版本 Android Studio 并已经安装了 mPaaS 插件，那么在您从低版本
Android Studio 升级至 3.6 版本的 Android Studio 之后，您只需要升级 mPaaS 插件至最新版本即
可。详情请参见 更新 mPaaS 插件。
  

安装 Android SDK
 
您需要安装 API Level 为 19 和 26 的 Android SDK：
 

在 Android Studio 中，通过 Android Studio > Preferences 打开设置对话框。
如下图所示，在 Android SDK 对话框中，勾选 API Level 为 19 和 26 的 SDK，然后点击 Apply 按
钮进行安装： 

  
安装 mPaaS 插件
 
mPaaS 插件提供多种开发辅助功能，包括：新建 mPaaS 工程，添加、删除和升级 mPaaS 组件，构建工程等
。安装步骤如下：
 

在 Android Studio 中，通过 Android Studio > Preferences 打开设置对话框。
点击左侧 Plugins，然后点击右上方的 
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3.

，并在下拉菜单中
选择 Manage Plugin Repositories。 

在弹出的 Custom Plugin Repositories 窗口中，点击 + 按钮，在新增的行中输入
https://mulei.oss-cn-hangzhou.aliyuncs.com/updatePlugins.xml，然后点击 OK。 
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4.

5.

返回 Plugins 窗口后，在 Marketplace 选项卡下搜索 mpaas。在搜索结果中，点击搜索到的
mPaaS 插件下方的 Install 安装该插件。 

等待插件安装结束，重启 Android Studio 后，您将在顶部的菜单中看到 mPaaS 插件： 
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1.

2.

3.

 
配置 Gradle 构建工具
 
您需要确保工程构建时使用 Gradle Wrapper：
 

在 Android Studio 中打开任意一个 Android 工程。
打开设置对话框。
如下图所示，在 Gradle 对话框中，勾选 Use default gradle wrapper，然后点击 Apply： 

  
配置 Linux 开发环境
 
按照以下说明配置 Linux 开发环境。 
说明：Linux 操作系统版本较多，本文仅适用于 CentOS 和 Ubuntu 版本。
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1.

2.

3.

1.

2.

1.

2.

3.

配置 Java 8 环境
 
mPaaS 框架只支持 JDK 8+：
 

下载并安装 JDK 8。
配置 JAVA_HOME 环境变量，并将 JAVA_HOME 下的 bin 路径添加到 PATH 环境变量中。
正确配置后，在命令行执行 java -version 命令，您将看到 JDK 版本等信息： 

  
配置 Gradle 4.4 环境
  
使用 Gradle Wrapper（推荐）
 

如果您的项目原先已经使用 Gradle Wrapper 进行构建，则建议在项目目录
/gradle/wrapper/gradle.properties 下把版本号修改为4.4。
如果您的项目没有使用 Gradle Wrapper，建议先使用全局的 Gradle（4.4）版本，然后调用
gradle wrapper --gradle-version=4.4 安装一个 gradle wrapper。完成上述步骤后，您只需要使
用 ./gradlew 的形式构建，这样的方式能最小的影响您的开发环境。
  

使用独立 gradle
 

下载 Gradle 4.4.zip。
解压 .zip 包，然后将解压路径配置为 GRADLE_HOME 环境变量，并将 GRADLE_HOME 下的 bin
路径添加到 PATH 环境变量中。
正确配置后，在命令行执行 gradle -v 命令，您将看到 Gradle 版本等信息： 

  
安装 32 位兼容库
 
CentOS 6、CentOS 7、Ubuntu 等 Linux 发行版默认去除 ia32-lib。所有 64 位 Linux 系统都需安装 32 位兼
容库。参照 android-sdk 中的安装方法:
 

Ubuntu:
sudo apt-get install zlib1g:i386
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1.

2.

1.

2.

安装并配置 Android Studio
  
安装 Android Studio
 
mPaaS 框架支持 3.6 及以上版本的 Android Studio。
 

关于 Android Studio 下载，请参见 Android Developers。
安装指南。
如果您之前使用的是低版本 Android Studio 并已经安装了 mPaaS 插件，那么在您从低版本
Android Studio 升级至 3.6 版本的 Android Studio 之后，您只需要升级 mPaaS 插件至最新版本即
可。详情请参见 更新 mPaaS 插件。
  

安装 Android SDK
 
您需要安装 API Level 为 19 和 26 的 Android SDK：
 

在 Android Studio 中，通过 File > Settings 打开设置对话框。
如下图所示，在 Android SDK 对话框中，勾选 API Level 为 19 和 26 的 SDK，然后点击 Apply 按
钮进行安装： 

  
安装 mPaaS 插件
 
mPaaS 插件提供多种开发辅助功能，包括：新建 mPaaS 工程，添加、删除和升级 mPaaS 组件，构建工程等
。安装步骤如下：
 

打开 Android Studio 设置对话框。
点击左侧 Plugins，然后点击下方 Browse repositories 按钮。 

CentOS:
yum install libstdc++.i686
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3.

4.

5.

6.

7.

点击下方 Manage repositories 按钮。 

点击 + 按钮。 

在弹出框 Repository URL 中填入 https://mulei.oss-cn-
hangzhou.aliyuncs.com/updatePlugins.xml，然后点击 OK 按钮。 

点击 Custom Plugin Repositories 对话框 OK 按钮，回到 Browse repositories 对话框。
在 Browse repositories 对话框左上方的搜索框中输入 mPaaS。等待搜索结束后，点击搜索到的
mPaaS 插件，然后点击插件右侧的 Install 安装该插件。 
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8.

1.

2.

3.

-

等待插件安装结束，重启 Android Studio，您将看到 mPaaS 插件： 

  
配置 Gradle 构建工具
 
您需要确保工程构建时使用 Gradle Wrapper：
 

在 Android Studio 中打开任意一个 Android 工程。
打开设置对话框。
如下图所示，在 Gradle 对话框中，勾选 Use default gradle wrapper，然后点击 Apply 按钮： 

 
  
切换工作空间（Workspace）
 
 
应用开发过程中，常会有更换应用环境信息或多套环境（即工作空间，Workspace）并行研发的需求。mPaaS
提供的工具可帮助您在开发过程中方便地进行环境切换。根据切换环境的需求不同，分为以下两种方式：
 

静态环境切换
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2.

3.

动态环境切换 
静态环境切换
  
前置条件
 
您已有 基于 mPaaS 框架 开发的 APP。更多信息参见 基于 mPaaS 框架 > 快速开始。
  
公有云
 
在公有云环境中，切换工作空间的步骤如下：
 

 
确保工程根目录 build.gradle 文件中，有如下依赖：
 

确保主工程（android main module） 的 build.gradle 中有如下配置（请注意顺序）： 

从控制台下载对应工作空间（Workspace）的 .config 配置文件。更多信息，请参考 在控制台创建
应用 > 下载配置文件。
 
将下载的 .config 配置文件添加到主工程（android main module）路径下。注意：仅保留对应工
作空间的配置文件即可。如下图所所示：
  

说明：因功能迭代，以下依赖的版本可能会不断增大。

 classpath 'com.alipay.android:android-gradle-plugin:3.0.0.6.1'
// 版本号必须大于 2.1.0
classpath 'com.android.boost.easyconfig:easyconfig:2.1.0'

 apply plugin: 'com.alipay.portal'
//位于 com.alipay.portal 之后即可
apply plugin: 'com.alipay.apollo.baseline.update'
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2.

3.

 
  

专有云
 
在专有环境中，切换工作空间的步骤如下：
 

 
确保工程根目录 build.gradle 文件中，有如下依赖：
 

确保主工程（android main module） 的 build.gradle 中有如下配置（需注意顺序）： 

从控制台下载对应工作空间的 .config 配置文件。更多信息参考 在控制台创建应用 > 下载配置文件
。
 
将下载的 .config 配置文件添加到主工程（android main module）路径下。注意：仅保留对应工
作空间的配置文件即可。如下图所所示：

说明：因功能迭代，以下依赖的版本可能会不断增大。

 classpath 'com.alipay.android:android-gradle-plugin:3.0.0.6.1'
// 版本号必须大于 2.1.0
classpath 'com.android.boost.easyconfig:easyconfig:2.1.0'

 apply plugin: 'com.alipay.portal'
//位于 com.alipay.portal 之后即可
apply plugin: 'com.alipay.apollo.baseline.update'
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5.

1.

2.

3.

-

 
使用 mPaaS 插件生成 yw_1222.jpg 加密图片。更多信息参见 加密图片（专有云）。
  

注意事项
 
easyconfig 工作原理：
 

能够修改AndroidManifest workspace 相关的 meta 属性。
修改 assets 下的 mpaas.properties 文件。
如果 mPaaS 工程配置文件中包涵 base64 属性且属性不为空，会生成无线保镖加密图片
yw_1222.jpg。
  

动态环境切换
 
动态环境切换指客户端不重新打包的情况下，通过修改手机设置中环境选项，动态修改应用的环境信息。
 

由于 mPaaS 安全验签机制的限制，更新环境配置信息会修改无线保镖验签 yw_1222.jpg 图片，因此动态切换
环境有两个限制：
 

仅适用于开发阶段：动态切换环境仅适用于开发阶段，上线前请注意删除对应的配置（Release 包会
报 RuntimeException 异常）。

说明：
动态环境切换适用于开发阶段多套环境并存且频繁切换的场景。1.

采用动态环境切换时需要向应用写入新环境的环境配置文件。因此在采用该方式时，您需要为应用申
请文件存储权限。

2.
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1.

2.

mPaaS 控制台需关闭网络请求验签开关，否则会因验签图片信息不对导致请求失败。
  

 
  

添加动态环境切换 SDK
 

在 portal 工程主 module 下面的 build.gradle 配置文件中的 dependencies 中添加以下依赖： 

将 portal 工程主 module 下面的 AndroidManifest.xml 中的 application 修改为如下配置： 

  
动态切换
 

 
扫描二维码下载 mPaaS 设置 APP。
  

dependencies {
···
bundle 'com.mpaas.mocksettings:mocksettings-build:1.0.0.200421111458@jar'
manifest 'com.mpaas.mocksettings:mocksettings-build:1.0.0.200421111458:AndroidManifest@xml'
····
}

<application
android:name="com.alipay.mobile.quinox.MockSettingsLauncherApplication"
android:debuggable="true"
···
>
···
</application>

移动开发平台mPaaS 接入 Android

176



  
安装完成后，显示 mPaaS 设置 APP 的图标如下：
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2.

i.

 
将 mPaaS 控制台下载的 config 文件放入手机 SD 卡中。
 
添加环境。通过 mPaaS 设置 APP 将 config 文件添加到列表中。
 

打开 mPaaS 设置 App。
 
点击 环境列表 页面底部的 添加环境配置文件。
  

 
 
找到要添加的环境配置文件。
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依次将两个文件（正式环境和测试环境）添加至环境列表。
  

 
 
切换环境。
 

 
选择上图中的一个环境，点击 切换，将其选中为当前环境。
 

 

 
 

说明： xxxx
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然后启动该环境所对应的 APP，测试请求可正常发送，说明环境切换成功。
  

  
此时若切换到另一个环境，再重启前一个环境所对应的 APP，由于新的环境内没有对应的
operationType，所以系统会报 3000 异常，这是已成功切换到另一个环境后的正常结果
。
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增加对 64 位 CPU 的支持
 
  
背景
 
为应对谷歌在 Google Play 上发布的应用必须支持 64 位 CPU 架构的要求，mPaaS 在特定基线上对此要求进
行了支持。如果您的应用需要在 Google Play 上发布，请联系技术支持人员或 提交工单 获取支持 64 位 CPU
的基线号，并参照本文中的 更新 SDK 和 生成 64 位/ 32 位 APK 完成适配，并按照 回归测试 的内容对适配进
行确认。
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1.

2.

3.

4.

5.

6.

1.

2.

更新 SDK
  
前提条件
 
已使用 mPaaS IDEA 插件管理依赖（即 portal 工程根目录下有 mpaas_packages.json 文件）。
  
操作步骤
 

更新 IDEA 插件 至最新版本。
为确保更新成功，请在备份后删除 portal 工程根目录下已有的 mpaas_packages.json 文件。
使用 IDEA 插件的 组件管理 功能，勾选 自定义基线，填入您获取到的基线号，点击 OK 。您也可以
参考 定制基线 以获得更多信息。
按照引导安装所需的组件。
如果您需要使用分享 SDK，请在 portal 工程主 module 下的 build.gradle 中添加依赖： 

mPaaS SDK 中已移除内置的高德定位、搜索、地图 SDK，如果您不需要使用 mPaaS 的定位组件
，请在 portal 工程主 module 下的 build.gradle 中移除 lbs 依赖： 

如果您需要使用定位组件，请自行集成高德官方提供的 Google Play 版本定位 SDK；如果您需要使
用小程序组件的地图功能，请自行集成高德官方提供的 Google Play 版本地图、搜索 SDK。
  

生成 64 位/ 32 位 APK
  
操作步骤
 

更新打包插件版本，确保 portal 工程根目录 build.gradle 中打包插件版本不低于： 

配置打包属性，portal 工程根目录 gradle.properties 中添加： 

bundle 'com.alipay.android.phone.mobilecommon:share-build:1.3.0.190929144835@jar'
manifest 'com.alipay.android.phone.mobilecommon:share-
build:1.3.0.190929144835:AndroidManifest@xml'

mpaascomponents {
excludeDependencies = [
"com.alipay.android.phone.mobilecommon:lbs-build"
]
}

classpath 'com.alipay.android:android-gradle-plugin:3.0.0.8.3'
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3.

-

-

点击 Android Studio 原生按钮或 mPaaS IDEA 插件打包按钮均可。也可以使用 Gradle 命令打包：
 

 
后续事项
 
检查 APK 是否为 64 / 32 位，解压 APK 或拖入 Android Studio 中查看 lib 目录（arm64-v8a 代
表 64 位，armeabi 代表 32 位）： 

  
回归测试
 

您需要分别对32位和64位 apk 做全量回归测试。
回归测试中您需要重点关注以下组件功能（如果使用）：
 

// 打32位 APK 就改成32
supportBit=64

gradle clean assembleRelease -PsupportBit=64

组件 验证项目

移动网关 - 开启 签名校验 后，RPC调用是否成功。
- 开启 数据加密 后，RPC调用是否成功。

热修复 - 热修复 是否能够生效。

UC内核

- H5容器使用UC内核 后，各项功能是否正常。
- 小程序 （必须使用UC内核），各项功能是否正
常。
- 小程序打开手机相册、拍照及预览 是否正常。
- 小程序发起http请求 是否成功（如果强制开启了
http）。
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1.

2.

3.

4.

5.

6.

  
适配 targetSdkVersion 28
 
  
背景
 
为应对谷歌在 Google Play 上发布的应用 targetSdkVersion 不小于 28 的要求，mPaaS 在特定基线上对此要
求进行了支持。如果您的应用需要在 Google Play 上发布，请联系技术支持人员或 提交工单 获取支持 64 位
CPU 的基线号，并参照本文中的 更新 SDK 和 适配 targetSdkVersion 28 完成适配，并按照 回归测试 的内容
对适配进行确认。
  
更新 SDK
  
前提条件
 
已使用 mPaaS IDEA 插件管理依赖（即 portal 工程根目录下有 mpaas_packages.json 文件）。
  
操作步骤
 

更新 IDEA 插件 至最新版本。
为确保更新成功，请在备份后删除 portal 工程根目录下已有的 mpaas_packages.json 文件。
使用 IDEA 插件的 组件管理 功能，勾选 自定义基线，填入您获取到的基线号，点击 OK 。您也可以
参考 定制基线 以获得更多信息。
按照引导安装所需的组件。
如果您需要使用分享 SDK，请在 portal 工程主 module 下的 build.gradle 中添加依赖： 

mPaaS SDK 中已移除内置的高德定位和搜索 SDK，如果您需要使用，可自行添加高德官方提供的

扫一扫

- 标准 UI 扫码是否成功。
- 标准 UI 打开手机相册、拍照及预览是否正常。
- 自定义 UI 扫码是否成功，如自定义 UI，需要 适
配部分新接口。

统一存储 - 数据库加密存储 是否正常。
- 文件加密存储 是否正常。

分享 - 分享到新浪微博、QQ 是否成功。

bundle 'com.alipay.android.phone.mobilecommon:share-build:1.3.0.190929144835@jar'
manifest 'com.alipay.android.phone.mobilecommon:share-
build:1.3.0.190929144835:AndroidManifest@xml'
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-

-

-

-

-

Google Play 版本 SDK。 
适配 targetSdkVersion 28
 
在 portal 工程主 module 下的 build.gradle 文件中修改属性 targetSdkVersion 28。
  
通用配置
 
修改 portal 工程 AndroidManifest.xml：
 

添加权限： 

application 节点下添加： 

LauncherActivity 删除以下属性（sdk 已改为通过代码设置）： 

 
其他配置
  
允许 http 请求
 
Android 9.0 的网络配置默认禁止了 http 请求，只允许 https 请求，设置 targetSdkVersion 28 将
在9.0+设备上启用 9.0 的网络配置。如果您仍然需要发送 http 请求，可通过配置
networkSecurityConfig 开启。
在 portal 工程 res/xml 下创建 network_security_config.xml 文件，内容如下： 

在 portal 工程 AndroidManifest.xml 中 application 节点添加属性： 

<uses-permission android:name="android.permission.FOREGROUND_SERVICE" />

<uses-library android:name="org.apache.http.legacy" android:required="false"/>

android:screenOrientation="portrait"

<?xml version="1.0" encoding="utf-8"?>
<network-security-config>
<base-config cleartextTrafficPermitted="true">
<trust-anchors>
<certificates src="system" />
</trust-anchors>
</base-config>
</network-security-config>
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-

-

1.

3.

4.

更多配置可参考 谷歌官方文档 。
  

透明背景 Activity 设置屏幕方向 crash
 
该适配点为 Android 8.0 系统 bug。在 8.0 设备上，当应用 targetSdkVersion > 26 时，透明背景的 Activity
如果设置了屏幕方向，打开该 Activity 就会触发 crash。触发具体条件为：
 

Activity 使用的 theme 中 windowIsTranslucent 或 windowIsFloating 属性为 true。
在 AndroidManifest.xml 中设置了 screenOrientation 属性，或调用了 setRequestedOrientation
方法。
 

您需要检查所有 Activity 是否满足触发条件，同时除了您自定义的 style 外，请注意部分常用的系统 theme 也
满足条件，例如：
 

推荐适配方式：
 

对于 theme 满足条件的 Activity，删除 AndroidManifest.xml 中 screenOrientation 属性，改为
调用 setRequestedOrientation 方法。
 
在对应 Activity 或父类中重写 setRequestedOrientation 方法，try catch
super.setRequestedOrientation() 兜底：
 

mPaaS 提供的 BaseActivity、BaseFragmentActivity、BaseAppCompatActivtiy 均已重写
setRequestedOrientation 方法兜底。
完成上述适配后，虽可避免 crash，但仍可能出现在8.0设备上锁定方向失效的情况，请确保您的
Activity 不会因旋转屏幕发生异常（例如重走生命周期导致某些成员变量为空）。
 

Android 8.0 系统相关源码：

android:networkSecurityConfig="@xml/network_security_config"

@android:style/Theme.Translucent.NoTitleBar
@android:style/Theme.Dialog

 @Override
public void setRequestedOrientation(int requestedOrientation) {
try {
super.setRequestedOrientation(requestedOrientation);
} catch (Exception ignore) {

}
}
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回归测试
 
全量回归测试的设备中必须包含 Android 9.0+设备，同时对于透明背景 Activity 设置屏幕方向 crash问题，请
在 Android 8.0 机型上专项测试。
 
回归测试中您需要重点关注以下组件功能（如果使用）：
 

  
常见问题

组件 验证项目

移动网关 - 开启 签名校验 后，RPC调用是否成功。
- 开启 数据加密 后，RPC调用是否成功。

热修复 - 热修复 是否能够生效。

UC内核

- H5容器使用UC内核 后，各项功能是否正常。
- 小程序 （必须使用UC内核），各项功能是否正
常。
- 小程序打开手机相册、拍照及预览 是否正常。
- 小程序发起http请求 是否成功（如果强制开启了
http）。

扫一扫

- 标准 UI 扫码是否成功。
- 标准 UI 打开手机相册、拍照及预览是否正常。
- 自定义 UI 扫码是否成功，如自定义 UI，需要 适
配部分新接口。

统一存储 - 数据库加密存储 是否正常。
- 文件加密存储 是否正常。

分享 - 分享到新浪微博、QQ 是否成功。
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1.

2.

3.

4.

 
查看以下常见问题列表，点击具体的问题即可查看相应解答。
 

 
编译时无网络连接
 
在编译文件时，如果没有网络，很有可能造成编译失败。通过以下步骤，确认编译环境的网络已连接。
 

确认已连接到互联网。
确认未连接网络代理，包括浏览器代理设置、第三方网络代理软件等。
确认未设置IDE代理。 

在 gradle.properties 文件中，确认未设置 Gradle 代理，即未设置 systemProp.http.proxyHost 
和 systemProp.http.proxyPort 属性。如果有设置，删除相关属性即可。 

编译时无网络连接-

程序编译失败-

编译过程中出现卡顿-

进行专有云接入是，下载配置、接入 mPaaS 后，编译不通过，出现 NullPointerException-

如何调试应用 以调试模式启动应用应用运行后调试-

mPaaS Inside 工程使用 MultiDex 的注意事项-

mPaaS Portal、Bundle 工程使用 MultiDex 的注意事项-

如何清除 Gradle 缓存-

升级到最新的 Gradle 插件 引入方式的变化使用方式的变化其他注意-

在华为 10 系统中 input file 标签无法打开相机 1. 升级基线2. 配置 FileProvider3. 实现
H5NebulaFileProvider

-
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1.

2.

3.

4.

5.

 
程序编译失败
 
如果程序编译失败，可通过以下步骤进行排错与解决。
 

根据 上文步骤，确认编译环境网络已正常连接。
检查 Gradle 执行记录，确认新增的依赖有效。
检查依赖的 GAV（group, artifact, version）参数设置正确。 

在系统自带的命令行工具中，执行以下命令，导出 Gradle 执行记录： 

查看步骤 4 中导出的记录文件，在最新生成的记录中，会看到类似如下记录，表示新增的依赖不存
在。 

//引用 debug 包group:artifact:version:raw@jar
bundle "com.app.xxxxx.xxxx:test-build:1.0-SNAPSHOT:raw@jar"
//引用 release 包group:artifact:version@jar
bundle "com.app.xxxxx.xxxx:test-build:1.0-SNAPSHOT@jar"
manifest "com.app.xxxxx.xxxx:test-build:1.0-SNAPSHOT:AndroidManifest@xml"

// 执行命令前，确认未定义 productflavor 属性。否则，命令会运行失败。
// 以下命令将执行记录导出至 log.txt 文件中。
gradle buildDebug --info --debug -Plog=true > log.txt

Caused by: org.gradle.internal.resolve.ArtifactNotFoundException: Could not find nebulacore-build-
AndroidManifest.xml (com.alipay.android.phone.wallet:nebulacore-build:1.6.0.171211174825).
Searched in the following locations:
http://mvn.cloud.alipay.com/nexus/content/repositories/releases/com/alipay/android/phone/wallet/neb
ulacore-build/1.6.0.171211174825/nebulacore-build-1.6.0.171211174825-AndroidManifest.xml
at
org.gradle.internal.resolve.result.DefaultBuildableArtifactResolveResult.notFound(DefaultBuildableArtifac
tResolveResult.java:38)
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6.

7.

8.

-

-

1.

2.

3.

4.

 
访问该记录中的 http 链接（如上一步所列记录中的第 3 行）并登录，查看 Maven 仓库。 

 
说明：您可以在 build.gradle 文件中查看登录时需要提供的账户名和密码。
 
 

执行以下命令刷新 gradle 缓存。 

如果 Maven 仓库有对应依赖，删除个人目录下 Gradle 缓存，然后重新编译。 
 
说明：删除 Gradle 缓存的方法如下。
 

在 MacOS、Linux、Unix等系统中，运行以下命令： 

在 Windows 系统中，默认情况下，路径定位到 C:\Users\\{用户名
}\\.gradle\caches，删除 modules-2 文件夹。

 
  

编译过程中出现卡顿
 
如果编译过程卡顿（等待超过 20 分钟），您可以通过以下步骤提高编译效率。
 

根据 上文步骤，确认编译环境网络已正常连接。
确认防火墙已关闭。
确认未开启 IntelliJ IDEA 编译器的网络配置。
在代码中，提前加载 Maven 镜像。例如，以下是阿里云加载 Maven 镜像的代码。
 

at
org.gradle.api.internal.artifacts.ivyservice.ivyresolve.CachingModuleComponentRepository$LocateInCach
eRepositoryAccess.resolveArtifactFromCache(CachingModuleComponentRepository.java:260)

gradle clean --refresh-dependencies

cd ~
cd .gradle
cd caches
rm -rf modules-2

apply plugin: 'maven'
buildscript {
repositories {
mavenLocal()

// 开始先加载 Maven 镜像
maven{ url 'http://maven.aliyun.com/nexus/content/groups/public/'}

maven {
credentials {

移动开发平台mPaaS 接入 Android

190



进行专有云接入是，下载配置、接入 mPaaS 后，编译不通过
，出现 NullPointerException
 

一般都是配置文件（conf 文
件）的问题，需要对字段进行检查。检查 13 个字段是否有缺少；和公有云下载过来的文件进行对比，确认字
段名是否正确。
  
如何调试应用
 
开发过程中需要调试代码，本文介绍两种调试方式。

username "请使用已知用户"
password "请使用已知密码"
}
url "http://mvn.cloud.alipay.com/nexus/content/repositories/releases/"
}
}
dependencies {
classpath 'com.android.tools.build:gradle:2.1.3'
classpath 'com.alipay.android:android-gradle-plugin:2.1.3.3.3'
classpath 'com.neenbedankt.gradle.plugins:android-apt:1.8'
}
}
allprojects {
repositories {
flatDir {
dirs 'libs'
}
mavenLocal()
maven {
credentials {
username "xxxxxxxxx"
password "xxxxxxx"
}
url "http://mvn.cloud.alipay.com/nexus/content/repositories/releases/"
}
maven{ url 'http://maven.aliyun.com/nexus/content/groups/public/'}
}
}
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以调试模式启动应用
应用运行后调试
  

以调试模式启动应用
 

 
使用场景：
  
希望调试应用启动时的最初代码，比如在 application init 时初始化代码。
 
 
操作步骤：
 
 
 
执行命令 adb shell am start -W -S -D 应用包名/应用第一个启动的页面类名。例如，mPaaS
Demo 的包名是 com.mpaas.demo，应用第一个启动的页面类名是
com.alipay.mobile.quinox.LauncherActivity，那么可以使用命令行 adb shell am start -W -S -D
com.mpaas.demo/com.alipay.mobile.quinox.LauncherActivity 以调试模式启动应用。第一个启
动的类名如下图所示。
  

 
 
执行命令之后，手机会弹出如下对话框。
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对希望调试的代码行设置断点，然后附着到应用所在进程即可，如图。
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应用运行后调试
 

 
使用场景：
  
在触发某个事件之后进行调试，比如点击某个按钮或者跳转某个页面才需要调试。
 
 
操作步骤：
  
在应用运行后，点击附着进程（

）按钮，或者在执
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3.

行上述命令后，再点击附着按钮开始调试。
 
  

mPaaS Inside 工程使用 MultiDex 的注意事项
 

 
接入 mPaaS Inside 的时候，我们已经提供了 MultiDex，因此您可以把官方提供的 MultiDex 从
implementation 中删除。
 

 
同时，建议您在 gradle 中的 android 这个模块下，把 multiDexEnabled true 加上。
 

 
如果您使用了 mPaaS Inside，同时不接入热修复，并且您需要 MultiDex 支持的话，您依旧要在
Application中调用MultiDex.install(this)。
 

如果您使用了热修复，也就是使用了 QuinoxlessApplication，您不需要在代码中显式调用。
 

MultiDex 是为了解决 Android 5.0 以下 Dex 方法的数量或者类的数量超过 65535 这个问题的方案。
 
在当前应用功能膨胀的情况下，我们需要对 Dex 做一些规划。
 
由于 mPaaS 接入方式是基于 bundle。在打包的时候，bundle 会尝试和用户的 Dex 做一次合并，但 mPaaS
会优先保证用户的首个 Dex 的顺序。
 
在这种情况下，为了接入 mPaaS，请您尽量避免在 Application 中添加过多的逻辑，使得第一个 dex 尽可能
的小。您可以使用 --main-dex-list 参数指定您在第一个 Dex 中的类。
 
如果您的 apk 中第一个 Dex 类过多导致 mPaaS 必要的几个 bundle 无法合并的话，可能在 Android 5.0 以下
的运行时环境中造成无法启动框架（ClassNotFound 或者 ClassNotDef 等问题）。
  

dependencies{
implementation 'com.android.support:multidex:1.0.3' //删除此行
}

android {
defaultConfig {
multiDexEnabled true
}
}

public class App extends Application() {
public void attachBaseContext(Context context) {
super.attachBaseContext(context);
MultiDex.install(this);
}
}
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1.

2.

1.

2.

mPaaS Portal、Bundle 工程使用 MultiDex 的注意事项
 
Portal 和 Bundle 不建议自行介入 MultiDex，除非您是单 portal 工程，需要使用multiDexEnabled true。如
果您的 Bundle 过大，目前只能使用拆分 bundle 的方式进行，不要在 bundle 中开启 multidex 支持。
  
如何清除 Gradle 缓存
 
打开 Gradle 插件的设置界面，点击 Clean Cache 按钮，即可删除 Gradle 插件的所有缓存数据。
 

  
升级到最新的 Gradle 插件
 
目前 Google 官方提供的 Android Gradle Plugin 是 3.5.x 版本。mPaaS 也提供了 3.5.x 版本的插件作为适配
，可支持 Google Android Gradle Plugin 3.5.3 和 Gradle 6.0 的 API。
  
引入方式的变化
 

您只需要通过添加以下依赖来引入我们的插件，不需要引入 Android Gradle Plugin 官方插件，因
为依赖传递的关系，会自动引入。 

Gradle Wrapper 的版本需要升级到 5.6 以上，推荐使用最新版 6.0.1。
  

使用方式的变化
 

不再需要使用 apply plugin:'com.android.application'，如果您是 portal 工程，仅仅需要 apply
plugin:'com.alipay.portal'。
如果您是 bundle 工程，也需要删除 apply plugin:'com.android.application', 仅需要使用 apply
plugin:'com.alipay.bundle'。

dependencies {
classpath 'com.alipay.android:android-gradle-plugin:3.5.2'
}
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3.

4.

5.

1.

2.

-

library 工程依然使用 apply plugin:'com.android.library'。
如果使用最新稳定版本 Android Studio 3.5 或以上，那么您需要在 gradle.properties 里面新增
android.buildOnlyTargetAbi=false。
由于我们的无线保镖组件暂不支持 V2 签名，如果您需要使用 Android Studio 调试并安装您的
APK，那么您需要禁用 V2 签名；如果您使用命令行进行构建，且您的 minSdkVersion 大于等于
24，则您也需要禁用 V2 签名。禁用 V2 签名的方式如下： 

  
其他注意
 

强烈推荐配合 inside 模式使用。
需要多观察确认 nebula metainfo 的问题。
  

在华为 10 系统中 input file 标签无法打开相机
 
由于华为10 系统 URI 的实现和标准 Android 存在部分差异，因此，在华为 10 上可能存在无法打开摄像机的
问题。您需要执行以下操作以解决这个问题。
  
1. 升级基线
 

如果您采用的是 32 系列基线，则需要升级至 10.1.32.18 及以上。

v2SigningEnabled false
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-

-

1.

2.

3.

如果您采用的是 60 系列基线，则需要升级至 10.1.60.9 及以上。
如果您采用的是 68 系列基线，则需要升级至 10.1.68-beta.3 及以上。
  

2. 配置 FileProvider
 
您可以复用您现有的 FileProvider，也可以新建一个 FileProvider。
 

新建 Java 类，继承 FileProvider 

在 res/xml 中新建 nebula_fileprovider_path.xml。 

在 AndroidManifest 中加入配置。 

  
3. 实现 H5NebulaFileProvider
 

 
新建 Java 类，实现 H5NebulaFileProvider，实现 getUriForFile 方法，在该方法中，调用上面实
现的 FileProvider 生成 URI。
 

import android.support.v4.content.FileProvider;
public class NebulaDemoFileProvider extends FileProvider {
}

<?xml version="1.0" encoding="utf-8"?>
<paths xmlns:android="http://schemas.android.com/apk/res/android">
<external-path name="external" path="."/>
</paths>

<provider
android:name="com.mpaas.demo.nebula.NebulaDemoFileProvider"
android:authorities="com.mpaas.demo.nebula.provider"
android:exported="false"
android:grantUriPermissions="true">
<meta-data
android:name="android.support.FILE_PROVIDER_PATHS"
android:resource="@xml/nebula_fileprovider_path" />
</provider>

public class H5NebulaFileProviderImpl implements H5NebulaFileProvider {
private static final String TAG = "H5FileProviderImpl";

@Override
public Uri getUriForFile(File file) {
try {
return getUriForFileImpl(file);
} catch (Exception e) {
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2. 注册 H5NebulaFileProvider。 
在 mPaaS 初始化完成之后，启动离线包之前，对 H5NebulaFileProvider 进行注册，注册一次即可
全局生效。 

 

H5Log.e(TAG, e);
}
return null;
}

private static Uri getUriForFileImpl(File file) {
Uri fileUri = null;
if (Build.VERSION.SDK_INT >= 24) {
fileUri =
NebulaDemoFileProvider.getUriForFile(LauncherApplicationAgent.getInstance().getApplicationContext(),
"com.mpaas.demo.nebula.provider", file);
} else {
fileUri = Uri.fromFile(file);
}
return fileUri;
}
}

H5Utils.setProvider(H5NebulaFileProvider.class.getName(), new H5NebulaFileProviderImpl());
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